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About the User Manual

This document contains the instructions for the operator of the Wisenet SSM Console Client program.
Please read this User Manual before using the product to ensure correct usage.

® This manual explains how to use the product based on the default values and the default screens.

® The information in this manual may vary, depending on the product's software update and our
policies, and is subject to change without notice to the user.

About Target Readers

This manual contains information for the operator using Wisenet SSM Console Client (hereinafter,
SSM Console Client) program.

® For details on how to install and set this product, please refer to the separate Administrator
Manual.

® You can download the Administrator Manual from Hanwha Techwin's product homepage
(http://www.hanwha-security.com).

About Product Usage

Users of this product can perform the following operations:

® Monitoring the network devices registered at Wisenet SSM Core Server (hereinafter, SSM Core
Server) in real time;

® Searching or playing the videos saved in the server and network storage devices;
® Monitoring the real-time events that occurred in the network devices or searching the event logs.

Before using this product, please make sure that the product is the latest software version. You
can visit Hanwha Techwin's product homepage (http://www.hanwha-security.com) to check and
download the latest software version.



About Copyright
©2020 Hanwha Techuwin Co., Ltd. All rights reserved.
Trademark

Each of trademarks herein is registered. The name of this product and other trademarks mentioned in
this manual are the registered trademark of their respective company.

Restriction

Copyright of this document is reserved. Under no circumstances, this document shall be reproduced,
distributed or changed, partially or wholly, without formal authorization.

Disclaimer

Hanwha Techwin makes the best to verify the integrity and correctness of the contents in this
document, but no formal guarantee shall be provided. Use of this document and the subsequent
results shall be entirely on the user’s own responsibility. Hanusha Techuwin reserves the right to
change the contents of this document without prior notice.
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Learn about Screen Configuration

When you run the SSM Console Client program, it displays the monitoring screen. You can use the
monitoring screen to perform various functions.

@ NOTE
® [fyou exit the program and resume it, you will see the last menu opened before exiting the program.

® You can change the startup option for the program using the path below:
SSM Console Client > Setup > General > Startup option
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Learn about Screen

SSM Console Client screens are configured as follows:

Q

NOTE

SSM Console Client screens may vary in configuration, depending on the menu tab you select.

UO!lQiﬂBuUOj U9912G 1N0ge uleaT

tion detection(Event ID : 1) Start

(4]
r log (cr‘\ﬁg\lr n Manager)
LIVE 11:32:57 e
Alarmoutput Layout PTZ #& b 6
Screen . N .
No. X . Detailed Description on Functions
Configuration
© | Menutab bar You can see all the menu tabs that are currently open.
. You can control the camera videos and audio, and split the video screens.
@® | Function buttons . . )
+ The configuration may vary depending on the menu tab you select.
You can see the tree for camera, alarm output, layout, and bookmark. You can
© | Treetab .
also control the videos of PTZ Cameras.
You can monitor the videos being recorded by the camera in real time.
O | Video window You can also search or play the videos saved in the server and network storage
devices.
. You can see a timeline of recorded videos while the program is in Playback
© | Timeline

mode.

Real-time events

You can see the real-time events that have occurred on your device.
« The configuration may vary depending on the menu tab you select.

Add-ons

You can use the add-ons the program provides.
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Learn about Menu Tab Bar

| Menu Overview

@] NOTE
The SSM Console Client program consists of menu tabs.

® You can freely move among the menu tabs to select the desired menu item.

® You can separate a page from the menu tab and run it like a separate program.

® You can insert a new page into the menu tab.

Monitoring

You can monitor a live camera feed and an event video in real time.

You can also search or play the videos saved in the server and network storage devices.

Search

You can search and play the event logs that occurred on your devices.

Also, by connecting to an Al camera, you can play videos or search for images in various
conditions such as people, face, vehicle, vehicle number.

Advanced search

You can search the thumbnails created at the moment when a motion detection event
occurred in the recorded video. You can also search for people passing through virtual
lines set on the recorded video, or search for people who are intruding into or loitering
within a specific area.

By linking with ANPR camera, you can monitor videos in real time, and search or play
any videos as you like. Also, you can register/delete vehicles, edit the registered vehicle

ANPR
information, and check the management history per vehicle.
« ANPR menu is available for use after registering your ANPR license.
You can monitor the data and the camera video of the POS device connected to the
POS NVR in real time. You can also search for the saved POS data or play the video of the
camera.
Dashboard You can monitor the status of SSM Core Server system or the registered device.

Configuration

You can configure and manage the SSM Core Server system.
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| Open a Menu Page

To open a menu page, click at the top left corner of the program, and select the desired menu
in the Add tab dialog box.

Tx

Add tab

Maonitaring

4 == SS5M Server(192.1¢

XND-6081FZ(19

| Close a Menu Page

To close a menu page, click. that appears when you hover the mouse cursor over the menu tab.

WA Menitoring 1] X +
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| Separate a Menu Page

Drag and drop the menu tab to separate a menu page.

e soro

@ NOTE
® You can freely move and insert the separated menu pages between different menus.

® The separated menu pages can be used as if they were separate programs.
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Learn about Function Buttons

UO!lQiﬂﬁuUOj U9912G 1N0ge uleaT

You can capture videos of the selected tiles.

You can print videos of the selected tiles.

You can remove all alarm displays of the monitored video tiles.

You can change the screen split of the video
window.

Clicking the button will automatically set the
screen split of the video window.

Click the button to add User Patterns.

You can remove all of the monitored video tiles.

You can view the video window in full screen on the monitor.

You can open or close the Virtual Matrix menu.

You can set whether or not to enable event spot.

[dEHEA B

You can show or hide the OSD information on the video.

You can check the video output information.

You can listen to the audio received from the camera or adjust the audio volume.

HI

You can audio-stream by playing the audio source set by the operator.
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0 You can speak into the microphone on the camera of the selected tile.

However, "Speak into the microphone" is only available for cameras that support microphones.

You can speak using the microphone to all cameras (max 16 cameras).

Learn about Tree Tab

Camera

You can see the list of cameras registered in SSM.

Alarm output

You can see the list of alarm output, or control the alarm output.

Layout You can see the list of layouts available in SSM, or create user layout.
PTZ You can control the videos of PTZ Cameras.
Bookmark You can see the bookmark tree you added in Playback mode.

You can show or hide the menu on the tree tab. You can set the display criteria for
the device list displayed in the tree.
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Learn about Timeline

PLAYBACK

You can search the recorded videos of the desired date from the calendar that appears
when clicking the date.

You can search the recorded videos by filtering by event item.

You can synchronize the playback time of multiple playback videos before playing or
release playback sync. (Playback sync/Individual playback)

You can only play back event video recordings displayed in the timeline through event
filtering. (Play filtered section/Play all)

You can move the recorded videos to the previous frame.

You can play the recorded video.

You can move the recorded videos to the next frame.

You can play the video in fast backward.

You can stop the video playback.

You can play the video in fast forward.

B ENEEQE

You can bookmark the video section of interest while in Playback mode.

You can export the recorded videos to a file.

« Export video: Export the recorded video of a certain section to a file.

« Export video masking: Export the video after setting some areas that need privacy
protection in the recorded video as a privacy area.

- Export one-time schedule: Export the video on the reserved schedule.

« Export schedule: Automatically export the video recording from the previous day at
the specified time on the next day on a daily basis.

Q

You can go to the Advanced search menu.

LIVE

PLAYBACK

You can switch Monitoring mode to Playback or Live mode.

@ NOTE
Switching Monitoring mode changes the mode of all video tiles collectively.

Learn about Screen Configuration | 17

UO!lQiﬂﬁuUOj U9912G 1N0ge uleaT



Learn about Menu Window

The screen configuration of the menu window may differ from menu to menu. For more information,
please refer to the screen configuration by menu.

Learn about Add-ons

When you select Change Password from the list box, you can change the password of

E the logged-in user.

When you select Logout from the list box, you can log out.

You can see the ID of the logged-in user.

You can check the fan, redundancy power supply system, and RAID status.
If alarm is triggered due to a hardware problem, you can turn it off by clicking [2@

« When an error occurs, =4 and SA appear in
turn; when the error is resolved, = is displayed.

. OKstate: iy mB b

« Error state: T @A i

« CPU usage: Displays the CPU usage of the
current PC.

+ Memory usage: Displays the memory usage of
the current PC.

« Network bandwidth: Displays the amount of
network input/output data of the current PC.

+ Scheduled export status: Displays the scheduled
export action status.
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You can set a screen lock.

Once button is clicked, the mouse cursor will changed to a locked shape and will be set
as locked. To undo the locked setting, click on the screen and enter the password to log
in. From full screen mode, users can set or undo the screen locks by pressing Ctrl + L.

You can set SSM Console Client.

You can check the SSM Console Client information.

You can minimize the SSM Console Client screen.

You can maximize the SSM Console Client screen.

You can exit SSM Console Client.
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Get Started

Learn how to run and log in to SSM Console Client program.

NOTE

To start SSM Console Client program, SSM Core Server must be operating normally.

Run the Program

To run SSM Console Client program:

® Double-click the SSM Console Client program icon on the desktop.

* You may also select [[l] > Wisenet > SSM Console.

Log in to the Program

When you run the SSM Console Client program, it displays the login screen as below.

NOTE

® Tologin to the SSM Console Client program, the status of all services of SSM Core Server must be
displayed as Started.

® The service status of SSM Core Server can be checked in SSM Service Manager's Service Status tab.

WISeNeT SSM console client

1015erver

user2

| SavelD

Auto login
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1. From the Server drop-down list, select SSM Core Server to connect to the SSM Console Client

program.

@ NOTE
® Ifyou can't find the server to connect in the drop-down list, click the [ button to the right of the
drop-down list, select 54 of the server to connect, and click OK.
® For more details about setup, please refer to the Administrator Manual or product homepage (http://
www.hanwha-security.com).

2. Enter your ID and password to log in.

[E] NOTE
® [fSave ID is selected, the ID entered in the login window will appear in the next access.

® |f Auto login is selected, it is automatically logged in to the program in the next access.

pa1Ie1S 195
]

3. Click the Login button.

@ NOTE
® [fyoufail to login, please check if the service status of the server is displayed as Started.
® When you fail to log in 3 times or more, Login restrictions status is set to block login for 30 seconds.
® The Login restrictions setting can be changed in the menu under the Configuration as below:
Configuration > System > Maintenance > Domain > Login restrictions

® Please change your Password periodically for security.
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Monitor

You can monitor the multiple camera videos registered in SSM Core Server in real time.

In addition, you can search and play the recorded videos stored in SSM Core Server and network
storage devices.

Open the Monitoring Menu Page

Run SSM Console Client. For more information, please refer to Run the Program.

Enter your ID and password in the Login dialog box, and click the Login button.

WISeNeT SSM console client

101Server o ]
user2

Login

¥ SavelD

Auto login
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® When you log in normally, the following initial screen appears.

10)IUO

Aamoutput layout PTZ & b

NOTE

SSM Console Client screens may vary in configuration, depending on the menu you select.

If you can't find Monitoring tab at the start of the program, click the [+] button at the top left of
the program, and select Monitoring from the Add tab dialog box.

A Advanced search +
Add tab

Monitoring

4 = 5S5M Server(192.1¢
KN

Configuration
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| Learn about Tree Tab

Learn about the screen configuration and key functions of the Tree tabs you mostly use on the
program's menu page.

I XND-8081VZ (192.165:
2020-05-08 11:21:26
Moti ction(Event I

User login (Configuration Manager)

LVE 113257

Aamoutput Layout PTZ &

Camera You can see the list of cameras registered in SSM.
Alarm output You can see the list of alarm output, or control the alarm output.
Layout You can see the list of layouts available in SSM, or create user layout.
PTZ You can control the videos of PTZ Cameras.
Bookmark You can see the bookmark tree you added in Playback mode.
You can show or hide the menu on the tree tab. You can set the display criteria for the
device list displayed in the tree.
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| Learn about Camera Tab

You can see the list of devices registered in SSM. You can preview the video on the camera, change
the device's connection status, or check the properties of the device. In addition, you can access
the device web viewer to change device settings remotely.

B Preview Camera Video
1. Click the Camera tab.
2. Hover the mouse pointer over the desired camera from the camera tree.

3. Check the thumbnails of the camera.

XNP-6320(192.168.219.209)

@ NOTE
If the device does not support preview, then the No preview support tooltip appears when you hover
the mouse pointer over it.

B Connect or Disconnect the Device
1. Click the Camera tab.
2. Select the desired device from the camera tree.

3. Right-click and select Connect or Disconnect.

4 = SSM Server(172.30.1.26)

Connect

Disconnect

Camera properties
Open setup page

Monitor | 25
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B See the Device or Camera Properties

1. Click the Camera tab.

2. Select the desired device from the camera tree.

3. Right-click and select Device properties or Camera properties.

B Open the Device or Camera Setup Page

1. Click the Camera tab.

2. Select the desired device from the camera tree.

3. Right-click and select Open setup page. The device's web viewer appears in the browser.

B Learn about Camera lcon

A

This is a normal camera that does not support PTZ functions.

This camera supports PTZ functions.

Recording a real-time video of the camera in progress.

It is displayed when the operator manually disconnects the camera.

It is displayed when the network connection with the camera is lost.

It displays a Box camera.

It displays a PT driver camera.

o S|

It displays a Fisheye camera.

CL

Display live cameras. (Videos cannot be recorded and can only be viewed live.)

It will be displayed if the video is being recorded on internal SD cards.

When a failover on SSM Core Server occurs, the
failover icon appears to the right of the camera icon.
XMNV-6010 Failover-occurred SSM Core Server is displayed as
disconnected.

SNEB-6004

26 | WISeNeT Wisenet SSM Console Client User Manual



| Learn about Alarm Output Tab

10)IUO

You can display and control the lists of alarm output for the devices registered in SSM Core Server.
Only the alarm output of devices that support alarm output is displayed.

H Enable/Disable Alarm Output
1. Click the Alarm output tab.
2. Select the desired alarm output in the alarm output tree.

3. Right-click and then click Alarm output on or Alarm output off.

| Learn about Layout Tab

You can monitor the camera video by splitting the video screen in various ways. You can set the
camera video array in Shared layout, Map layout, and User layout. In addition, when you use
sequence function, you can monitor multiple layouts in order.

B Learn about Shared Layout

You can monitor the camera video with a layout set in Configuration. You can change shared
layout settings in Configuration > Design > Layout.

@ NOTE
Shared layout is available for the entire users registered in the same domain.

B Learn about Map Layout

You can monitor the camera video on the map or the plan. You can change map layout settings
in Configuration > Design > Map.

B Learn about User Layout

You can monitor the camera video with a layout you created.

@ NOTE
User layout is only available for logged-in user and cannot be shared with other users.

B Learn about Sequence

You can monitor the camera video after placing multiple camera videos on two or more shared
layouts, then switch the layouts in order.
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| Learn about PTZ Tab

You can control the camera video registered in SSM. You can control the PTZ functions of the PTZ
camera and adjust the digital zoom, DIS, and focus of the normal camera.

@ NOTE
® Supported PTZ specifications may vary, depending on the camera model.

® Evenifyou have a box camera that does not have PTZ functions, you can use some functions when
Fish Eye is set.

® PTZ functions may not be supported, depending on the camera model. For more information, please
refer to the User Manual of the camera.

® ForFisheye or SUNAPI cameras, Set home position function is available.

® You can select the PTZ cameras and press the arrow keys to control the PTZ cameras in the selected
direction.

B Learn about PTZ Control Buttons and Functions
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Screen . N q
No. ) . Detailed Description on Functions
Configuration
Enter camera setu . . .
(1) menu P You can display the camera setup menu on the video in OSD format.
Exit camera setup . .
(2] menu You can close the camera setup menu displayed on the video.
. . You can click the button to change the zoom magnification of the video
© | Original size ) )
zoomed in or out with area zoom set as x1.
o Move among You can click the arrow buttons on the camera setup menu displayed in
camera menus OSD format on the video to move the menu up, down, left, and right.
You can control the direction of the PTZ cameras by clicking and
PTZ ball ) o .
dragging the ball inside the circle.
Sensitivity You can adjust the PTZ control sensitivity.
You can manually adjust the focus of the camera. Values in the drop-
@ | Focus setup down list indicate the focus shift interval, and the n button shifts the
focus nearby and the n button shifts the focus faraway.
© | Simplefocus You can automatically adjust the focus of the camera.
© | Open/Close iris You can open or close the iris of the camera lens.
You can zoom in/out on the video magnification with optical zoom of
PTZ cameras, and adjust the zoom speed. The value in the drop-down
® | Zoom setup . o
list indicates the zoom shift interval. The E button and button
zoom out/in on the video, respectively.
@ | Preset You can use the camera's preset movement functions.
@ | Trace You can use the camera's trace function.
® | Group You can use the camera's group function.
® | Swing You can use the camera's swing function.
® | Tour You can use the camera's tour function. Tour supports Device tour set by
the camera and SSM tour set by SSM Configuration.
You can use the camera's DIS function. You can click the button to set
@® | DISon/off

DIS to stabilize shaky videos, and click again to release DIS.
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@ NOTE
Refer to the following description for terms related to camera functions.

Simple focus: Function to automatically adjust the focus based on the user-specified position on the
screen or the entire screen

Preset: Function to call the specific positions of specified PTZ cameras

Trace: Function to call the travel path of the specified PTZ cameras to move them

Group: Function to call the specified multiple presets in sequence

Swing: Function to move two preset sections repeatedly with the camera moving back and forth
Tour: Function to call multiple groups of the specified presets in order

Auto tracking: Function of PTZ cameras to automatically track moving objects

DIS: Function to automatically stabilize shaky videos when shaking is detected for more stable camera
video

| Learn about Bookmark Tab

You can display the added bookmark tree in the Playback mode or play the recorded video when
setting a bookmark. You can also change the bookmark name or delete the bookmark.

@ NOTE
® You can add up to 10,000 bookmarks.

When the maximum number of bookmarks is exceeded, the oldest bookmark currently stored will be
deleted.

B Check Bookmark Tree

® Abookmarkis displayed with a triangle at the bottom of the timeline.

® You can double-click the bookmark in the bookmark tree to move directly to that video.

® You can select the desired bookmark in the bookmark tree to play, rename, and delete
bookmarks you have added.
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| Learn about Setup Tab

You can click the . button to the right of the tree tab to change the device list display based on

the Device or Site.

® Device: SSM Core Server-registered devices are displayed.

e Site: The site-registered device list is displayed.

| Learn about Shortcut Menu

You can sort the devices in the tree tab or control the tree.
When you right-click the tree tab, the shortcut menu appears.

Hide IP

Sort by name

Sort by registration date
Sort by connected
Expand tree

Collapse tree

Hide IP

It does not display the IP address of the device when displaying the name of
the device.

Sort by name

You can sort devices by device name.

Sort by registration date

You can sort devices by the registration date.

Sort by connected

You can sort devices based on their connection status.

Expand tree

All devices registered in SSM Core Server are displayed at once.

Collapse tree

All devices registered in SSM Core Server are hidden.

Monitor | 31
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Monitor Live Videos

You can monitor camera videos of the network devices registered in SSM Core Server in real time.
Open the Monitoring menu page.

Double-click the desired camera from Camera tab. Or select the desired camera from Camera tab
and drag it on a tile of the video window.

W Monitoring 1

2020-05-07 | »

NOTE

® When you double-click the camera, the camera videos will be placed from the tile at the top left of the
video window in order.

® |fyou double-click the same camera repeatedly, video feed from the same camera will be place
multiple times on top of another.

® Double-click a DVR or NVR registered on the 'SSM Server' to view all videos registered to said device.

® You can double-click 'SSM Server' at the top of the tree to place all cameras registered in the server on
the tiles at once.

® When you click a video tile and drag it on another tile in a different location, you can switch the
locations of the tiles.

® Double-click the desired video from a video split-screen to monitor it on one large screen. While doing
s, you can click on the < or > button at the bottom right of the video to view the previous or next
video.
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Learn about the Video Window Configuration

TNF-9010 CH001(192.168.219.100) o
2021-07-14 17:30:03

I3

o

No. Screen Configuration Detailed Description on Functions
It displays the camera name and IP address.
@ | Cameraname/IP address | It displays the set camera name if you have set the Use device
name option via Settings > Display > Show tree.
® | Date/Time It displays the date and time of the video.
@ It is displayed when the camera certificate of the selected video is
- valid.
(3) . It is displayed when the selected video is saved on your PC.
1 Lo . . .
m It is displayed in the event of a parking detection event.
It is displayed when the camera disconnects due to an unstable
network connection.
It is displayed when you do not have playback permissions due to
an excessive number of users.
It is displayed when the number of users allowed for simultaneous
playback has been exceeded.
(4] Video input Itis displayed in th f video |
status tis displayed in the event of video loss.

It is displayed when the image has no recording data.

It is displayed when the camera is not connected.

It is displayed when you do not have monitoring permissions for
the live or playback video.
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Monitor Real-time Events

You can check the real-time events of the network devices registered in SSM Core Server in the Real-
time events window.

frame rate of t

XND-8081VZ (19241

2126
ection(Event ID : 1) Start

492
User login (Configuration Manager)

LIVE 1132557 0

Alamoutput layout PTZ % b

Screen
No. ) . Detailed Description on Functions
Configuration

- You can view or search a list of the real-time events that occurred in the
(1) Event list device.
- When a new event occurs, a list of events is added in order.

i You can see the live or event video when instant viewer is enabled. The setup
mode is maintained even if SSM Console Client program is restarted.

+ You can search events using Event filter Al BestShot filter
desired parameters.
+ You can set the priority of

Camera Camera
events to be displayed in the O All cameras O Cameras on layout
[2) Real-time events window. You D ® Ssecedcameresen fyout
L. @ Selected cameras on layout ¥| Object type
. can set the priority of events @ Priority B peron
in Configuration > Event > A Very High B e

Management menu. @ High B verice

¥ Normal

¥ Event Type

M| Event related to video

¥ Event not related to video

You can remove all the event lists displayed in the Real-time events window.

3]

You can open or close the event window.
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| Preview Event Information

10)IUO

When an event occurs, you can preview the information of the event in the Real-time events
window.

If you want to see the detailed information about the event, double-click the event. Instant viewer
runs.
B Eventtab

It displays the name of device where the event occurred, occurred time, colors by event type
and event name.

m Al BestShot tab

It displays the name of device where the event occurred, occurred time, colors by event type
and bestshot.

e 185035
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| Use Instant Viewer

Double-clicking the event executes the instant viewer, and the video at the time of the event is
played back. You can find the detailed information regarding events such as camera name, event
type, occurred time, etc. in the Instant viewer.

@ NOTE
For details about the Instant viewer's functions, please refer to the pages linked by the links below.

® | earn about Timeline

e (Control Playback Speed

® (Confirm Events

B Event Instant Viewer

Carnera  TID-G00R

o 1 ]
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B Instant Viewer for Al BestShot
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Camera
PMND-AS081RYV_C
Occurred (Devic

(Vehicle)

Obiject properti
Bus, White

Screen . .. q
No. X . Detailed Description on Functions
Configuration
(1) Digital zoom You can zoom in/out on the video on the tile with digital zoom.
Camera name You can check the name of the camera where the event occurred.
. . You can play the recorded video of an event that occurred or check the
Video tile ) .
real-time videos from the camera.
Control playback You can control the playback speed when playing the recorded videos. For
speed more information, please refer to Monitor > Control Playback Speed.
Unlock A Call button push detection event occurs when the door unlock function
has been requested via an alarm output due to a Call event on the
0 Broadcast to intercom device. In such a case, you can switch the mode to live and have a
selected camera two-way call via the intercom device or unlock the door.
. You can control the timeline when you play the recorded video of an event
(7] Timeline
that occurred.
0 Switch to live You can play a video recorded at the time of an event or switch the mode
Switch to playback | to areal-time live video feed of the camera.
(9] Event details You can see the detailed information about the event.

Monitor | 37



Screen

No. Configuration

Detailed Description on Functions

(10} Confirm event

You can change the event status after confirming the event.

You can check the history of the event status by clicking History in
Event details when confirming the event in the Event menu. For more
information, please refer to Confirm Events.

Alarm type

You can set Alarm type after confirming the event.

Confirm/Cancel

You can confirm and close the situation of the monitoring event. Clicking
the Confirm button changes the event status to "Confirmed."

| Event Terminology

Event Name

Description

Motion detection

An event occurs when motion is detected in the area of interest set in the
camera.

Video loss

An event occurs when DVR, NVR, encoder device cannot receive camera videos.

Intelligent Video

You can search all the Intelligent Video Analytics (IVA) events by grouping them

Analytics (IVA) all together.
) An event occurs when an object crossing a virtual line set on the camera is
Crossing
detected.
Enter An event occurs when a moving object enters from outside to inside of the
virtual area set in the camera.
Exit An event occurs when a moving object exits from inside to outside of a virtual
area set on the camera.
An event occurs when an object that does not exist in the virtual area set by the
Appear/Disappear camera remains in the area for a certain period of time or when an object within

the area does not exist for a certain period of time.

Tampering detection

An event occurs when the camera video is hidden or the camera position is
changed.

Auto tracking

An event occurs when the moving object is automatically tracked on the camera
video.

Face detection

An event occurs when a person's face is detected on the camera video.

Audio detection

An event occurs when audio is detected at the level set by the camera.

Failed to connect

An event occurs when the camera cannot be connected.

Connect camera

An event occurs when the camera is connected.

Disconnect camera

An event occurs when the camera is disconnected.

Defocus detection

An event occurs when the defocusing of the camera lens is detected.
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Event Name Description
Intrusion An event occurs when a moving object is detected within the virtual area set in
the camera.
Loitering An event occurs when motion of a loitering object is detected within the virtual

area set in the camera.

Fog detection

An event occurs when the camera detects foggy or cloudy images.

Scream An event occurs when the camera detects a screaming or shouting person.
Gunshot An event occurs when the camera detects gunshots.
Explosion An event occurs when the camera detects an explosion.

Crashing glass

An event occurs when the camera detects the sound of shattering glass.

Temperature change
detection

An event occurs when a sudden temperature change occurs in the area of
interest set in the camera.

Shock detection

An event occurs when a shock or vibration is detected on the camera or when a
change in physical location of the camera is detected.

Alert for video
recording

An event occurs when the incoming frame rate of the recording profile is lower
than the configured value.

Object detection
(Person)

Object detection
(Vehicle)

Object detection
(Face)

Object detection
(License plate)

An event occurs when a preset object such as a person, face, vehicle, or license
plate is detected by the camera.

Face mask detection

An event occurs when the face of a person wearing or not wearing a mask is
detected on the camera screen.

Estimated body
temperature detection

An event occurs when temperature equal to or higher than the specified
temperature level is detected by the camera.

Occupancy monitoring
(over the limit)

Occupancy monitoring
(under the limit)

An event occurs when the number of people is over or under the specified value
of indoor capacity set for the camera.

Parking detection

An event occurs when a vehicle parks in or out of the parking lot.

Social distancing
detection

An event occurs when the distance between people is closer than the distance
set on the camera.

Call button push
detection

An event occurs when the camera detects a call request.

Tampering switch
detection

An event occurs when it detects manipulation of the camera's tampering switch.
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Control Tile Videos

You can monitor camera videos and control the videos on tiles.

| Control Tiles

A variety of features listed below are readily accessible by using the feature icons on top of the
video tile.

COdLramE L

Screen

X . Detailed Description on Functions
Configuration

For videos supporting the wiper feature, you can click the button to
automatically stop the camera's wiper after a certain amount of time..

You can start or stop the auto tracking feature of the PTZ camera.
'Alt-click’ the tracking target to start auto tracking it.

Digital PTZ profile can use the auto tracking feature.
However, you cannot 'Alt-click’ a target to auto track it.

You can control the operations of PTZ cameras.
Enter or leave PTZ control mode.

For videos that support thermal camera functions, you can click desired
locations to verify temperature information.

You can capture a video of a tile and save it as a. jpg file. You can change the
storage path for the captured image files in the SSM Console Client settings.

You can record a video of a tile on your PC. When you click the button, the
video is recorded on your PC, and when you click again, the recording is
stopped.

You can zoom in/out on the video on the tile with digital zoom.

You can adjust brightness and contrast of video or set them to default.

BEEDEEEEREE
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| Controlling the PTZ Camera

Clicking &g will display = in the center of the screen, and move to PTZ Control Mode.

Q

10)IUO

NOTE

® Depending on the camera, there may be discrepancies in PTZ control functions and speeds.

Fine adjustment of camera direction

Moving the cursor on to 9F will bring up 8 direction arrow keys, which disappear when the
cursor moves away from the arrow key area. Click on the arrow keys to make fine adjustments
to the camera directions. Keep clicking on the arrows to move the cameras in the desired
direction.

Rapid adjustment of camera direction
Click on 4+ and drag to move the screen in the desired direction.

The distance of the drag will determine the speed of the movement of the screen.

Move to center screen

Clicking on a specific location on the screen will cause the video in that location to move to the
center of the screen.

Expand selected area

Dragging a specific area of the screen will expand the selected area and move it to the center of
the screen.

Expand and Shrink videos

Use the mouse wheel to increase or decrease the size of the videos, and drag the desired area

to increase the video size. To return the video to the original size, click &2)}.

Monitor | 41



| Learn about Shortcut Menu

When you right-click the tile, Shortcut menu appears. Shortcut menu may appear differently
depending on the monitoring mode.

Remove video

You can close camera videos of the selected tiles.

You can switch from Live mode to Playback mode.

Playback
It is available in Live mode only.
¥ You can switch from Playback mode to Live mode.
ive
It is available in Playback mode only.
When playing multiple camera videos in Playback mode, all cameras can
Playback sync be played from the same playback time. It is available in Playback mode
only.
OosD You can display the title, date, and time of the camera on the video.

Video information

You can display the video information of the selected tiles.

You can capture the videos of the selected tiles and save them as a .jpg

Capture file. You can change the storage path for the captured image files in the
SSM Console Client settings.
Print You can print videos of the selected tiles.

Local recording

You can record the videos of the selected tiles on your PC. When you click
the button, the camera videos are recorded on your PC, and when you
click again, the recording is stopped.

It is available in Live mode only.

Device recording

You can record the videos of the selected tiles on your device. When you
click the button, the camera videos are recorded on your device, and
when you click again, the recording is stopped.

It is available in Live mode only.

Listen

You can listen to the audio received from the camera. When you click the
button, you can listen to the audio from the camera, and when you click
again, it is set to silent.

Microphone on

It performs "Speak into the microphone" on the camera of the selected
tile.

It is available in Live mode only.

@ NOTE
"Speak into the microphone" is only available for the cameras
supporting microphone.

Broadcast to selected camera

You can broadcast the desired sound files through the camera of the
selected tile.
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Send to wall

You can output the video and audio of the selected tile to the desired
location of the video wall.

10)IUO

Aspect ratio

You can zoom in or out on the video screen to view videos by the size of
the tiles while maintaining the aspect ratio of the camera video resolution.

Original size

You can view the video with the actual resolution size of the camera video.

Flip

You can flip the video of the tile upside down.

Defog

You can correct the camera video on foggy or overcast days.

Clicking » button displays setup values. When Off is set, the defog
function is disabled, and when Auto is set, the surrounding environment
is detected for the camera to correct the video automatically. When you
set "1 to 10" (hereinafter, defog level), you can directly set the amount
of correction based on the surrounding environment. Even if the degree
of fog decreases, you can set it to Manual to continuously operate the
function up to the set defog level.

The higher the defog level, the sharper the video will appear. Increasing
the defog level when the degree of fog is low may cause the screen to
look dark.

It is available in Live mode only.

Reset all alarms

You can remove all alarm displays on the video tiles.

Itis available in Live mode only.

Profile

You can display the profile lists supported by the camera and change the
profile of real-time videos.

It is available in Live mode only.

Camera properties

You can see camera properties of the selected tiles. You can check the
camera name, device model, video resolution, video and audio codec, and
camera functions in the Camera properties dialog box.
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Use Video Layout

You can monitor multiple camera videos at once by splitting the video screen in various ways. You can
set the camera video array in Shared layout, Map layout, and User layout. In addition, when you use
sequence function, you can switch among multiple layouts sequentially to monitor camera videos.

| Learn about Shared Layout

You can easily monitor the camera video using the layout specified in Configuration. You can set
shared layout in Configuration > Design > Layout.

NOTE

Shared layout is available for the entire users registered in the same domain.

| Learn about Map Layout

You can monitor the camera video on the map or the plan, rather than the split video tile. You can
set map layout in Configuration > Design > Map.

| Control Map Layout Screen

The set map is displayed when the desired map layout is double-clicked. A Control button appears
when the cursor is in the top-right corner of the maps, and the map layout can be moved or
zoomed in/out.

Available parking space (%) Available space Total number of parking space
Total  100% 1% 14
Mapl  100% 7 7
Map2  100% 7 7

o B Map2

1 Map3

TNF-9010_CHOOY

(2]
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No.

Screen Configuration

Detailed Description on Functions

g Map2

[E Map3

10)IUO

You can double-click the Map button to quickly move to the desired map.
+ The background color of the Map button flickers when an event occurs
for the camera of the selected map.

The video window is displayed when the camera icon is double-clicked.

+ The background color of the camera icon flickers when an event
occurs for the camera. An instant viewer is displayed when the
flickering icon is double-clicked.

You can increase the window size every time you double-click the video

window.

« Click the video window and drop it on the desired location to move its
location.

« Click the video window and press the Delete key to delete the video
window.

You can rotate the map layout. (Counterclockwise/Front/Clockwise)
+ The angle of the map layout can be changed when dragged with the
mouse while holding the right-click.

You can move the map layout to the direction displayed on the button.

(Top/Bottom/Left/Right, Top/Bottom Left, Top/Bottom-Right, Center)

« The layout can be moved to the desired location when dragged with
the mouse while holding the left-click.

You can drag the pointer to the top or bottom to zoom in or out the map
layout.
+ Using a scroll wheel also enables the layout to be zoomed in or out.
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| Learn about User Layout

You can monitor the camera video freely with a layout you added.

[E] NOTE
User layout is available for the applicable user only.

B Add User Layout
1. Click the Layout tab.

2. Click the [+] button to the right of User layout.

Shared layout

Sequence

3. Select the added layout.

Shared layout

4. Select the Tools tab at the top left of the Monitoring menu page.
Click the E button to select the desired screen split.
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® (lick the button to add the desired screen split.

H Edit User Layout

Shared
p'." f_.
User
MyLayout01 a

Sequence

When you click the . button to the right of the user layout, you can duplicate

Duplicate
P the user layout.
Delete When you click the i button to the right of the user layout, you can delete the
user layout.
Rename When you double-click a user layout, you can rename the user layout.
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| Change Layout

You can change the layout of the video window to the various layouts you have already specified.

1. Click the Layout tab.

2. Double-click the layout you want to change among Shared layout, Map layout, and User
layout.

| Learn about Sequence

You can monitor the camera video after placing multiple camera videos on more than one shared
layout or user layout, then switch the layouts in order.

@ NOTE
You can only run the sequence when you set 2 layouts or more.

B Add Sequence
1. Click the Layout tab.

2. Click the [+] button to the right of Sequence.

Shared laya

> Map la
> User layout -+
Sequence |+

3. Enter the sequence Name in the Sequence dialog box.

Sequence

Dwell time | 105

Use |Layout

Narme

Cancel
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4. Click the [+] button in the Sequence dialog box.

10)IUO

Sequence

Dwell time | 105

N N B

Use |Layout

5. From the Layout drop-down list, select the shared layout to be added.

Sequence
Dwell time | 105
]

Use |Layout

6. Repeat Steps [2] to [4] more than once to add multiple layouts in Sequence.

7. Set Dwell time, and then click the Apply button.

@ NOTE
Dwell time refers to the time spent for switching from the current layout to the next layout.
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H Play Sequence

When you play a sequence, you can switch among multiple layouts sequentially to monitor
videos of multiple cameras at once.

1. Click the Layout tab.

2. Select the desired sequence in the sequence list.

Shared la

SEQUENCE

T lobby | 2 &
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B Edit Sequence

You can change the setting value of the sequence already specified.

10)IUO

1. Click the Layout tab.

2. Select the sequence to edit in the sequence list.

Shared layout

3. Clickthe . button to the right of the sequence name.
4. Modify the desired items in the Sequence dialog box.

You can edit Dwell time, Conversion wait time, and Shared layout. In addition, you can
change the playback order of the shared layouts or change the sequence name.

5. Click the Apply button.

B Delete Sequence
1. Click the Layout tab.

2. Select the sequence to delete in the sequence list.

3. Click the . button to the right of the sequence name.
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Monitor Recorded Video

You can search or play the recorded videos stored in SSM Core Server or network device. You can
search the recorded videos of the camera by date or event. You can play and monitor the recorded
video that you searched.

| Switch to Playback Mode
You can switch to Playback mode while monitoring the real-time video of the camera.

1. Select the desired video tile in the video window.

2. Click the button at the bottom right of the Monitoring menu page.
A video recording taken five minutes before the live hour is played back.

LIVE 10:01:58

® You can right-click on the video tile to select Playback, or you can click the timeline to
switch to Playback mode. To play back a video recorded at a specific time, click the time on
the timeline.

@ NOTE
® Switching to Playback mode switches the mode of all video tiles to play.

® Switching to Playback mode displays the timeline at the bottom as the timeline of the selected tile.

®  When you click the button in Playback mode, you can switch to Live mode.
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| Learn about Timeline
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Switching to Playback mode displays a split marker bar on the timeline below the page. The split
marker bar is only displayed in the section with recorded videos.

Timeline is displayed on a daily basis (24 hours), and when you click the time, the recorded video at
that time is played. When you start playback, the search date and playback time are displayed. You
can then monitor while controlling the playback speed.

0 06 0060 (7] 000
x : o

m PLAYBACK

Screen
No. ) . Detailed Description on Functions
Configuration

(1) n You can search the recorded video of the previous date.

This displays the search date. When you click this date, a calendar is
displayed. You can search the recorded videos of the applicable date when
you click the desired date from the calendar. For more information, please
refer to Search the Recorded Videos by Date.

[5) 2019-10-07

You can search the recorded video of the next date.

You can search the recorded videos by filtering the event items.

You can synchronize the playback time of multiple playback videos before
playing or release playback sync. (Playback sync/Individual playback)

You can only play back event video recordings displayed in the timeline
through event filtering. (Play filtered section/Play all)

You can control the playback speed when playing the recorded videos of the
camera.

You can bookmark the video section of interest while in Playback mode.

You can export the recorded videos to a file.

« Export video: Export the recorded video of a certain section to a file.

« Export video masking: Export the video after setting some areas that need
privacy protection in the recorded video as privacy areas.

« Export one-time schedule: Export video according to the reserved
schedule.

« Export schedule: Automatically export the video recording from the
previous day at the specified time on the next day on a daily basis.

You can go to the Advanced search menu.
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17:34:39

When there is a recorded video on the search date, the split marker bar is
displayed on the timeline.

You can switch Monitoring mode to Playback or Live mode.

@ NOTE
1o Switching Monitoring mode changes the mode of all video tiles
collectively.

B Use Shortcut Menu

You can set the time interval when you refresh, back up, or search the real-time recording status
on the timeline.

Reset time The start time and end time tooltips for setting the time interval for backup, bookmark,
range and search menus appear. For time settings, you can enter a time value, either by
9 clicking and moving the tooltip to the left or right or by double-clicking the tooltip.
Refresh This searches the recorded videos stored in SSM Core Server or network storage
timeline device once again to update and display the real-time recording status on the
timeline.

@] NOTE
()

The split marker bars on the timeline are displayed in different colors depending on the event type of
the recorded videos. For more information, please refer to Search the Recorded Videos by Event.

® You can zoom in or out on the timeline by scrolling a mouse wheel over the timeline.

® When you click the timeline and drag it to the left or right, you can move the time on the timeline.
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| Search the Recorded Videos by Date

You can search the recorded videos stored in SSM Core Server or network storage device with the
date on the calendar.

1. Switch to Playback mode.
2. Select the video tile to search.

3. Click the date on the timeline below.

PLAYBACK

4. Select the desired date when the calendar appears. The dates with the recorded videos are
indicated with an orange block.

PLAYBACK

5. Thetime line of the selected date is displayed on the screen. Clicking on the desired time on the
time line will play the video from the designated time.
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Search the Recorded Videos by Event

You can search the recorded videos of cameras, filtering by event.
1. Switch to Playback mode.

2. Select the video tile to search.

3. Click the Jjll button at the top left of the timeline.

PLAYBACK

4. Select the desired event in the Filter dialog box.

Filter

5. Click the Apply button. The recorded video of the filtered event is displayed on the timeline.

6. To play back a filtered event video recording displayed in the timeline, click the Play filtered
section button.

PLAYBACK
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| Recording Event Terminology

Event Name

Description

Object detection

A recording event occurs when the Al camera recognizes a person, vehicle, face,
or license plate.

Sound classification

A recording event occurs when a sound classification event such as scream,
gunshot, explosion, or glass breaking is detected by the camera.

Two-way audio

A recording event occurs when sounds being sent to the camera are output or
saved.

Alarm input

A recording event occurs when an alarm input is detected.

Auto recovery backup

This displays the recorded video section saved with Auto recovery backup.

Auto recovery backup is a function to backup the recorded video from a camera
when network is unstable and cannot record from disconnection point to
reconnection point.

User defined event

A recording event occurs when an event specified in Configuration is detected.

It means that camera videos are recorded continuously without any event

Continuous .

separation.

Device recording is available only when the camera registered in the storage
Manual device does not have the recording schedule or event recording is set. Right-

click the video tile and click Device recording to record camera videos on the
storage devices.
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| Synchronize Playback

When playing multiple recorded videos, all the video tiles can be played from the same date and
time. When you click the button, the playback times of all the video tiles are synchronized. When
you click the button again, playback sync is released, and you can play the videos individually per
tile.

1. Switch to Playback mode.
2. Select the tile that is the basis of the playback time.

3. Click the . button at the top left of the timeline. The videos of all the tiles are played,
matching the date and time of the selected tile.

PLAYBACK

E] NOTE
® Playback syncis only available in devices supporting playback sync.
® |f playback syncis set, you cannot search the recorded videos by tile.

® You can click the el button to release playback sync and enable individual playback by video tile.
Y lick the el b I layback d enable individual playback by video til

| Control Playback Speed

You can control the playback speed when playing the recorded videos.

You can fast rewind the playing video.

You can play -1x, -2x, -4x, -8%, -16x, -32x, -64x and -128x with each click of the button.

You can pause the playing video.

You can fast forward the playing video. You can play at 1x, 2x, 4x, 8%, 16x, 32x, 64x, and 128x
speed with each click of the button.

You can move to the previous frame while pausing the video.

You can play the recorded video.

You can move to the next frame while pausing the video.

The current playback speed is displayed, and the desired playback speed can be chosen.
Depending what the device supports, users can choose from 1/2x or 1/4x slow playback.

=
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| Add Bookmark

You can bookmark the video section of interest while in Playback mode. You can check the
bookmarks you added in Bookmark tab. For more information, please refer to Use Bookmark >
Add Bookmark.

10)IUO

| Switch to Live Mode
You can switch to Live mode while playing the recorded video of the camera.

1. Select the desired video tile in the video window.

2. Clickthe button at the bottom right of the Monitoring menu page. You may also right-
click the video tile and click Live.

PLAYBACK

@] NOTE
® Switching to Live mode switches the mode of all video tiles to Live.

® Switching to Live mode resets the timeline at the bottom to an empty timeline.

® When you click the button while in Live mode, you can switch to Playback mode.
Live cameras will not switch to playback mode.
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Export Recorded Videos to a File

You can export the recorded videos stored in SSM Core Server or network storage device to a file. You
can immediately export the recorded videos to a file or export them to a file according to a schedule
after setting the schedule. In addition, you can hide some areas of the recorded video in privacy areas
and export them to a file.

@ NOTE
® FExportis also available in the Advanced search menu.

® [fyou export the recorded video in AVI file format, then a new file is created in the following cases:
-~ When the video resolution of the recorded video is changed
-~ When the audio or video codec of the recorded video is changed
- When file size of the exported video is 2GB or more

® [fyou export the recorded video in SEC file format, two files are created in the recording path.
— The SEC extension file is the exported video.
— The EXE extension file is a viewer program.

® The exported video file can be played as follows:

— When you run an EXE file with the same name as the SEC file, you can play it in Backup viewer,
which is a video playback program for SEC file only.

- AVifiles can be played in normal video playback programs.
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| Export Video

You can export some sections of the recorded video to a file.

1.

N

w

»

Switch to Playback mode.

. Select the video tile to export.

Click the . button at the top right of the timeline.

Click Export video.

Export video masking

Export cne-time schedule

Export schedule

5. Select one or more cameras in the Export video dialog box. You can export multiple camera

videos at the same time.

Export video

No. Camera Storage

I T [T
Remote v

Re

e
e
e
e
e
e

Time range

Waiting
Waiting
Waiting
Waiting

6. Set the time range of the recorded video to be exported from the timeline. Use the time tooltip

on the timeline to change time settings. For more information, please refer to Set Time Interval.
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7. Set the Path to store the export files.

rrnat

8. To export videos in high definition, check the Export video in high resolution box.
® Videos will be exported at low resolution if this option is not used.

® This setting will only work when low resolution and high resolution videos are being
recorded simultaneously.

9. SetFile format.
When you select SEC file, the following options are available.

® Support simultaneous multiple camera playback: When playing multiple recorded videos
in Backup viewer after exporting them, you can play the recorded videos from multiple
cameras at the same time.

® Enable SEC file encryption: When using a SEC file format, you can set a password in the
export file.

NOTE
E] ® When you play the exported file in Backup viewer, you must enter the password before playing.
® Ifyou lose your password, then you will not be able to play the exported file.
10.To check the estimated size of the exported file, click the Check estimated capacity button.

® Only the size of video recordings stored in the SSM Core Server can be checked.

® This function cannot be used when multiple cameras have been selected including cameras
from network storage devices other than the SSM Core Server.

11. Click the Export button.

Click the Cancel button to cancel the export.
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| Export Video Masking

10)IUO

You can export the video after setting some areas of the video as privacy areas. Privacy areas can
be set in areas where privacy is required or in areas where monitoring is not required.

@ NOTE
It supports the SEC file format only.

B Selecting a masking mode

1. Select the video tile to export.

2. Click the . button at the top right of the timeline.

PLAYBACK

3. Click Export video masking.

Export video

|Export video masking|

Export cne-time schedule
Export schedule
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4. Select a masking mode from the Export video masking dialog to set your privacy area.

XRN.6410DB4_CHO05

09:33:08
18:00:00
)

Enatile

00 3 -

Static masking: Masks privacy areas set up for a specific location for a set period of
time. Up to 16 privacy areas can be set, and a different application time can be set for
each area.

° - Linear path masking: Sets specific locations as privacy areas, and mask the areas
along the linear path that connects all of them.

° Mouse track masking: Masks along the path of the freely moved mouse by clicking
privacy areas playing the video.

o n Al auto masking: Al camera masks all objects selected based on the search
conditions (people, face, vehicle, and vehicle number).

® By clicking m you can select the masking type you want. By clicking -

you can preview it.
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5. The privacy area you set is added to the list of masked areas. Set the time range to apply the
privacy area, and then click the Apply button.

10)IUO

XRN.6410DB4_CH005

~_

00w | ~ | noooo - BN

M

09:45:14
06:00:00 18:00:00
L]

® (lick . to delete a privacy area you set.

® (lick . to show or hide a privacy area.

6. Setthe time range of the recorded video to be exported.

1%

09:46:14
06:00:00 18:00:00
[ I

Time range 050000 &~ [1gomag *

¥ Enable E il Enable

7. To export videos in high definition, check Enable of Export video in high resolution.
® Videos will be exported at low resolution if this option is not used.

® This setting will only work when low resolution and high resolution videos are being
recorded simultaneously.

8. If you want to use the encryption to a SEC file, check Enable of Enable SEC file encryption
and set a password.

9. Set the Path to store the export files.

10. Click the Export button.
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B Setting the Linear path masking

1.

2,

Select the video tile to export.

Click the . button at the top right of the timeline.

Click Export video masking.
Select .
Play the video, and pause it when the object to mask appears on the screen.

Set a rectangular area by dragging the mouse so that the object to mask is hidden.
If the rectangular area is set for the first time, it is added to the list of masked areas.
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7. Play the video again, and pause it where it is needed to modify the location or size of the
masked area along the path of the moving object.

19:00:00

8. Click the rectangular area set for the first time and drop it in a location where modification is
needed to modify the location or size of the masked area.
Repeat this step as many time as necessary to set the masked area.

9. When the setup is complete, play the video of the masked area to check or change the
setup.
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B Setting the Mouse track masking
1. Select the video tile to export.

2. Click the . button at the top right of the timeline.
3. Click Export video masking.

4. Select .

5. Play the video, and pause it when the object to mask appears on the screen.

6. Seta rectangular area by dragging the mouse so that the object to mask is hidden.
If the rectangular area is set for the first time, it is added to the list of masked areas.

182004

7. Click the Bl button to select the playback speed.
Click the ® button in the rectangular area to play the video.
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8. When the video plays, click the rectangular area and drag the mouse along the moving
object.

9. Drop itin a location where you want to end the masking, and click the () button inside the
rectangular area.

The video will stop and the masking will be terminated.

18:20:08 ° ~

182010

I N Y I

Enatile

10.When the setup is complete, play the video of the masked area to check or change the
setup.
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| Export One-Time Schedule

You can export the recorded videos to a file on a schedule after setting the export schedule.
Export one-time schedule is performed only once.

B Use Add Schedule Mode
You can set Export one-time schedule.
1. Switch to Playback mode.

2. Select the video tile to export.

3. Clickthe . button at the top right of the timeline.

PLAYBACK

4. Click Export one-time schedule.

Export video
Export video masking

|Export one-time schedule|
Export schedule

5. Select Add schedule mode in the Export one-time schedule dialog box.

xport one-time schedule
ule mode Schedule list mode

~ 00:00:00

@ NOTE
In Live mode, camera list is not displayed.
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6. Set Schedule to export. You can set it by clicking the arrow or manually inputting the date &
time in the scroll box.

7. Select one or more desired cameras. You can schedule for simultaneous export for multiple
camera videos.

e schedule

edule mode hedule list mode

- ! ra ge
OND-5071 Femate
y R

D HOO1

8. Set the time range of the recorded video to be exported. Use the time tooltip on the
timeline to change time settings. For more information, please refer to Set Time Interval.

9. Set the path to store the export files.

10. Set File format.
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11. To export videos in high definition, check the Export video in high resolution box.
® Videos will be exported at low resolution if this option is not used.

® This setting will only work when low resolution and high resolution videos are being
recorded simultaneously.

12.1f you want to use the encryption to a SEC file, select Enable SEC file encryption.

13. Click the Add button. Schedule list mode is enabled and you can check the schedule added.

Export one-time schedule

Add gchedule mode @ Schedule list mode

Schedule 1

Mo, Carmer End time

A [ Start time
"B | | GND-GOVOR(1S2. 165, 219,148) 2015-11-22 10:48:4b DST: 0 2015-11-;

B Use Schedule List Mode

When you select Schedule list mode in the Export one-time schedule dialog box, you can
check the all schedule lists. You can check whether the scheduled export is completed in Status
column of the schedule table, and you can also modify or delete the schedule.

t one-time schedule

edule mode

ttime End tirme Schedule Status

B-11-22 10:48:45 DST: 0 2019-11-22 15:3606 DS1: D 1/22/2019 00:00:00
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| Export Schedule

10)IUO

You can automatically export the recorded videos of previous date stored in SSM Core Server
every day at a specified time on the next date. You can also check the status of the scheduled
export that you have already set.

NOTE
@ For Export video, Export video masking, and Export one-time schedule in the Monitoring menu, you
can export the recorded videos of the camera to files just once.

B Set up Schedule

You can schedule to automatically export the recorded videos from the previous date that its
device is registered in SSM Core Server every day at a specified time on the next date.

1. Click the . button at the top right of the timeline.
2. Click Export schedule.

Export video

Export video masking
Export one-time schedule
|Export schedule |

3. Select the desired device from the Device list.

Device list

I use Name 1P address Schedule [l Repeat = Progress
] B S5M Server 172.30.1.48:4510 ]
XNP-6320 172.30.1.6 Schedule Always
] XNF-8010R 172.30.1.5 Schedule Always
] XND-8081VZ 172.30.1.4 Schedule Always 1]
] XND-6081FZ 172.30.1.3 Schedule Always [v]

4. Select a schedule in the drop-down list.

Export schedule
Device list

M use Name 1P address Schedule B Repeat
& S5M Server 0.1.48:4510

XD 30 Schedule Always

XNF-8010R Schedule Always
XND-B0BIVZ 172.30.1.4

Schedule None
XND-6081FZ 172.30.1.3 SOETaE AIWays
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5. Configure the repeat feature of export. If Repeat is unchecked, export is executed only once
and the feature will be disabled.

Device list

M use Name 1P address Schedule ¥ Repeat Progress

] & SSM Server 172.30.1.48:4510 |

XNP-6320 172.30.1.6 Schedule Always [ ]
] XNF-8010R 172.30.1.5 Schedule Always [ ]
] XND-8081VZ 172.30.1.4 Schedule Always [ ]
] XND-6081F7 172.30.1.3 Schedule Always | ]

6. Check the Enable box for Scheduled export.

Scheduled export information

Scheduled export Enable

Edit schedule E3

Start time 12:00:00

Name. 1P address Schedule [ Repeat  Progress

]

EEEEN

& SSM Server 172.30148:4510
XNP-6320 17: ‘Schedule Always
XNF-8010R 17230.15 schedule Always

XND-8081VZ 172.30.1.4 Schedule Always
File format ® sEC AT

EEEEN

XND-6081FZ 172.30.1.3 Schedule Always

Export video in high
resolution Enable

Enable SEC file encryption [ Enable
Password
Confirm Password
Digital signature [ enable
EELIRE ¥ Continuous ¥ Alarm input
¥ motion ¥ video loss
¥ 1vA (intelligent Video Analytics)
¥ Audio detection ] Manual

Badap Path cserstpubiciDocuments\y [

Set Auto Delete
Minimum free space
File retention period [ Enable

Overvite [ Enzble

7. Set the Start time for Scheduled export. You can either click the button on the scroll box or
input the time in the cell.

8. Set the File format for export.

® SEC: This is a file format for Hanwha Techwin videos. When you run an EXE file with the
same name as the SEC file, you can play the exported video in Backup viewer, which is a
video playback program for SEC files only.

® AVI: You can play the exported video in normal video playback programs.

9. To encrypt an SEC file, check the Enable box for Enable SEC file encryption.

NOTE
@ ® When you play the exported file in Backup viewer, you must enter the password before playing.

® Ifyou lose your password, then you will not be able to play the exported file.
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10. Select the Event type of the video for the scheduled export.

10)IUO

11. Set the path to store the files for scheduled export.

12.1f you want to automatically delete the videos after the scheduled export, specify the Set
Auto Delete.

® Minimum free space: You can set the minimum free space on the disk where the exported
videos are saved. Once the free space on the disk reaches the specified minimum free
space, you can no longer export videos to the disk.

® File retention period: You can set the exported video file to be automatically deleted
after the set period.

® Overwrite: When there is no space available on the disk, you can set it to overwrite the
previously exported file.

13. Click the Apply button.

B Check Backup Status

You can check the scheduled export status by device in the Status column in the Device list.

Export schedule

Device list

I use Mame IP address Schedule I Repeat Progress

& S5M Server 172.30.1.48:4510
XNP-6320 172.30.1.6 Schedule Always Export complete
XNF-8010R 172.30.1.5 Schedule Always
XND-8081VZ 172.30.1.4 Schedule Always
XND-6081FZ 172.30.1.3 Schedule Always

B Edit Schedule

You can add, edit, or delete schedules to be exported.

1. Click the . button at the top right of the timeline.
2. Click Export schedule.

Export video
Export video masking

Export cne-time schedule
|Export schedule |
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3. Click the Edit button of Edit schedule from the Export schedule dialog box.

Expo
Device list

1P address

172.30.0.5
XND-8081VZ 172.30.1.4
XND-6081FZ 172.30.1.3

Schedule

‘Schedule Always
Schedule Always
Schedule Always
Schedule Always

Repeat

Progress

4. Click the Add button under User schedule.

dule information

Name
Schedule1

UserSchedulel

Scheduled export information

Scheduled export

Edit schedule

Start time

File format

Export video in high
resolution

Enable SEC file encryption

Password
Confirm Password

# Enzble

12:00:00

® sEC AT

™ Enzble

Enable

@ NOTE
Shared schedule can be configured in Configuration > System > Schedule.
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5. Enter Name and Description in Schedule information.

6. Select Cycle for the schedule.
® Daily: Sets the schedule on a daily basis.
® Weekly: Sets the schedule on a weekly basis.

7. Select a time to schedule from the time cell under cycle and click the Set button.
® To clear the schedule, select the area to clear and click the Clear button.

® Time cells in multiple sections can be selected by using the [Ctrl] key or dragging the
mouse.

® The Min setting dialog box appears when the selected time cell is double-clicked. Set
the minutes of Start time and End time and click the OK button.

Min setting

Start time

End time

8. Click the Apply button.
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Use Bookmark

You can bookmark the video section of interest while in Playback mode. You can also play or edit the
bookmark added.

E] NOTE
® Bookmark is also available in the Advanced search menu.

® You can bookmark only when you recorded the camera video in the SSM Core Server.

| Add Bookmark

1. Switch to Playback mode.
2. Select the video tile to add as a bookmark.

3. Click the . button at the top right of the timeline.

4. Enter Name and Description in the Bookmark dialog box.

End tirme

Enable evidence locking

5. Set Start time and End time of the bookmark. For time settings, you can enter a time value
either by clicking and moving the time tooltip on the timeline to the left or right or double-
clicking the tooltip. For more information, please refer to Set Time Interval.

14:10:31 15:09:00
W N ([N | — ELAYEACK

6. To prevent the video recordings within the bookmarked section from being deleted when the
video is overwritten, check the Enable evidence locking box.

7. Click the Apply button. You can check the bookmarks you added in Bookmark tab.
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| Play Bookmark

1. Click the Bookmark tab at the bottom left of the menu page.

Camera Alarm output Layout PTZ

2. Select the desired bookmark.

4 XNP-6320(192.168.219.209)

3. Click the ﬂ button to the right of the selected bookmark. The bookmarked recorded video is
played.

4 XNP-6320(192.1
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| Modify Bookmark

1. Click the Bookmark tab at the bottom left of the menu page.

Camera Alarmoutput Layout PTZ

2. Select the desired bookmark.

4 XNP-6320(192.168.219.209)

3. Click the button to the right of the selected bookmark.

4 XNP-6320(192

4. Modify the desired configurations in the Bookmark dialog box. Use the time tooltip on the
timeline for bookmark time settings. For more information, please refer to Set Time Interval.

bookrmark]

End time

Enable evidence locking

5. Click the Apply button. You can check the information of the bookmark you modified in the
bookmark tree.
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| Delete Bookmark

1. Click the Bookmark tab at the bottom left of the menu page.

Camera Alarmoutput Layout PTZ

2. Select the desired bookmark.

4 XNP-6320(192.168.219.209)

3. Click the i button to the right of the selected bookmark.

4. Click the Apply button.
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Move to Advanced Search Menu

When you click the . button on the time line, you can easily move to the Advanced search menu
page without adding an Advanced search menu tab in the menu tab.

In the Monitoring menu playback mode, the recorded images of the camera are searched and played
back, but in the Advanced search menu, various advanced search functions such as motion search
or Intelligent Video Analytics (IVA) are available. For more information, please refer to Search the
Recorded Videos.

Set Time Interval

You can set the start time and end time when exporting bookmarks or recorded videos to a file or
using the search menu.

® You can modify time values by clicking and moving the time tooltip on the timeline to the left or
right or double-clicking the tooltip.

® When you can't find the time tooltip, right-click on the timeline and click Reset time range. Then,
the time tooltip appears on the timeline.

@ NOTE
You can set the desired time interval when using bookmarks or search menu.
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Control Video Wall

SSM can be linked with SSM-VM to monitor high-quality videos from the network devices in Video

wall. You can also control the settings of Video wall set by SSM-VM (Virtual Matrix) in SSM Console
Client easily.

@ NOTE
® To control the Video wall in SSM Console Client, SSM-VM must be installed.

® You can edit the information of the Video wall set by SSM-VM in SSM Console Client, but you can't
save the edited information in SSM-VM automatically. To save the changed setting information,
change the Video wall settings in SSM-VM.

Open the VM Menu

Click the E button from the Function Buttons at the top right of the Monitoring menu page.
The VM menu appears in the Monitoring menu.

123)
XNP-6320(192.168.219.4)

Alarmoutput Layout PTZ & b
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Learn about Screen Configuration

VM menu screen is configured as follows:

W Monitoring 1

No.

Screen Configuration

Detailed Description on Functions

e

Video wall setup

You can select the video wall or wall mode.

Video wall

You can preview the selected Wall mode.

®

Monitor Layout

You can preview the layout of the selected monitor in the video wall.
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| Learn about Video Wall Setup

wall layout

lIBA O3PIA [02UOD

No. Screen Configuration Detailed Description on Functions
Video wall You can select the desired items from the Video wall list.
You can select Wall layout, Wall sequence, Wall spot, or Direct Wall
Wall mode . :
Display from the Wall mode list.
) 0SD You can display items such as Date & Time, Camera name, Display
event, IVA rules, etc. on the video tile of the video wall.
You can set and configure the selected wall mode.
« When you select the wall mode as Wall layout, you can select the
desired items from the Wall layout list.
O | Detailed options « When you select the wall mode as Wall sequence, you can select the

desired items from the Wall sequence list.

« When you select the wall mode as Wall spot, you can select the

desired items from the Wall spot list.
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| Learn about Video Wall

O | —

6 Camera Group
[Row:2

No. Screen Configuration Detailed Description on Functions

@ | Name You can check the name of the Wall mode.
Preview You can preview the selected Wall mode.
Return to previous Wall You can display as the Video wall mode before it was changed to the
Spot mode Wall spot mode.
Selected monitor screen You can import the screen of the selected monitor to the video
import window of SSM Console Client.
Startup option You can start or stop the selected Wall mode.
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| Learn about Monitor Layout

o Monitor layout :

0 Source:

lIBA O3PIA [02UOD

w

Monitor layout :

No. Screen Configuration Detailed Description on Functions

@ | Name You can check the name of the monitor layout.

@ | Preview You can preview the layout of the selected monitor in the video wall.
© | Camerainformation You can check the camera information of the selected tiles.

@O | Clearevent You can remove events displayed on the selected tiles.

© | Clearall events You can remove events from all the tiles.

@ | Changetile pattern You can change the layout pattern of the monitor.

(7] Remove the selected tile You can remove the camera videos from the selected tiles.

0 Remove all tiles You can remove the camera videos from all the tiles.

© | Load last settings You can revert the edited monitor layout to the monitor layout set by

SSM-VM.
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Set as Wall Layout

You can set the Video wall for the Wall layout mode.

1. Select the desired Video wall from the Video wall list.

Video wall Control Center

Wall layout

Last wall layout : new wall Iz

4. The selected wall layout is displayed in the Video wall, and the changed wall layout is also
displayed on the monitor of the video wall (VMD VIEWER).

Wall layout wall layout

Last wall layout : wall layout

Camera Group
[Row:2

@J NOTE
You can set various wall layouts in SSM Console Client. For more information, please refer to the Set Edit
Monitor Layout.
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Set as Wall Sequence

You can set the video wall for the Wall sequence mode. When you set the wall sequence, you can
switch among multiple wall layouts sequentially in the Video wall to monitor videos from cameras.
For more information, please refer to the SSM-VM Product Instruction Manual.

1. Select the desired Video wall from the Video wall list.

r [ [ [ ¢
ce s = =) | =

wall display

Video wall  Control Center
Wall sequence

\ all
Wall sequence : New Wall 55 Wall Sequence

4. To run the wall sequence, click the E button. The wall sequence is played on the monitor
(VMD VIEWER) of the video wall.

@ NOTE
To stop the wall sequence, click the [l button.
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Set as Wall Spot

You can set the video wall for the Wall spot mode. When you set the Wall spot mode, you can set the
video wall to change to the specified wall layout when an event occurs on a specific camera. For more
information, please refer to the SSM-VM Product Instruction Manual.

1. Select the desired Video wall from the Video wall list.

r [ [ [ ¢
s TN B

Video wall  Control Center

Wall spot

N all
Wall spot : New Wall Spot || wall Spot

4. To run the wall spot, click the E button. The changed wall spot is started on the monitor (VMD
VIEWER) of the video wall. When an event occurs on a specific camera as set in SSM-VM, the video
wall changes to the wall layout set for the wall spot.

@ NOTE
® Tostop the wall spot, click the E button.

® To return to the previous layout after the wall spot has run, click the button.
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Set Direct Wall Display

Direct Wall Display is a function that allows users to play video wall sequences simply by selecting
multiple cameras and then clicking the E button.

@ NOTE
® Direct Wall Display is a one-time function, so the setting value is not saved in SSM Console Client.

® The wall layout is displayed based on the last layout set in the Video wall.

1. Select the desired Video wall from the Video wall list.

Video wall | Control G

Wall layout
| Wa

3. Select the desired camera from the Camera tab, and then drag and drop it into the Direct Wall
Display window. Alternatively, you can select the tile videos in the video window, and then drag
and drop them.

Beo) [PNM9320V0P_CH005(192.168.2172)

® *
7 o
F o
¥
e
[ 4

LIVE 18:34:27
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4. Set the dwell time of the video wall.

Direct wall display

5. To start the Direct Wall Display, click the E button. The camera list set in the Video wall layout
will change by dwell time order.

@] NOTE
® To stop the Direct Wall Display, click the E button.

® To select multiple cameras from the Camera tab, you can select only the desired cameras by pressing
the Ctrl or Shift key.

® You can click "SSM Server" at the top of the tree to set all cameras registered in the server at once.

® To change the camera order in the Camera list, select the desired camera and then drag and drop it to
the new position to change the camera position.

® To delete one camera from the Direct Wall Display window, you can press the Delete key to delete
it.

® Todelete all the cameras from the Direct Wall Display window, you can click the ﬁ button to
delete all of them.
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Edit Monitor Layout

You can easily edit the monitor layout of the video wall in SSM Console Client. When you edit the
monitor layout, your edits are immediately reflected on the monitor (VMD VIEWER) of the Video wall.
However, they are not immediately reflected when the Wall mode is running.

® Change to Shared Layout
® Monitor Camera Videos in the Camera Tab
® Monitor Tile Videos in the Video Window

® Monitor Map Layout Icons

PNF-9010RV(192.168.-

LIVE 16:00:45

Camera  Alarm output
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| Change to Shared Layout
1. Select the Layout tab from the tree tab on the Monitoring menu page.

2. Select the desired layout from the Shared Layout list, and then drag and drop it into the
Monitor Layout window. The monitor of the video wall changes to the selected layout.

| Monitor Camera Videos in the Camera Tab
1. Select the Camera tab from the tree tab on the Monitoring menu page.

2. Select the desired camera from the Camera list, and then drag and drop it into the Monitor
Layout window. The videos of the selected camera appear on the monitor of the video wall.

| Monitor Tile Videos in the Video Window

1. Select the videos of the desired tiles in the Video window on the Monitoring menu page.

2. Drag and drop the selected tiles into the Monitor Layout window. The videos of the selected
tiles appear on the monitor of the video wall.

| Monitor Map Layout Icons
1. Select the Layout tab from the tree tab on the Monitoring menu page.
2. Select the desired map layout and double-click it.
3. Select the icon in the map layout.

4. Drag and drop the selected icon into the Monitor Layout window. The videos of the selected
icon appear on the monitor of the video wall.
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Show OSD in Video Wall

You can display items such as Date & Time, Camera name, Display event, IVA rules, etc. on the video
tile of the Video wall. For more information, please refer to the Set Console Client > Set Display >
OSD text.

Show 0SD

On

B Date/Time B Information icon

Camera name W IVA rules

M Show IP

M Enable Devices' Default Name

M Display event 10s
Date/Time

Date format 2019-11

Time format

con size

Font size

Icon size
Map layout tile size

Size
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Search the Recorded Videos

You can search and play the event logs that occurred on your devices. Also, by connecting to an Al
camera, you can play videos or search for images in various conditions such as people, face, vehicle,
vehicle number.

@ NOTE
To use Al search when Al cameras have been linked, you must configure the following settings in the
camera web viewer.

® WEBVIEWER > Analytics > Object detection > Enable object detection
e WEBVIEWER > Analytics > IVA > Enable IVA

Open the Search Menu Page
1. Run SSM Console Client.
2. Enter your ID and password in the Login dialog box, and click the Login button.

3. Click the [+] button at the top left of the program, and then select Search in the Add tab dialog
box.

W Menitoring 1 +
Add tab

Monitaring

= =

hboard

Configuration

010R(192
XNP-6320(1
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Searching Events

You can search and play the event logs that occurred on your devices. You can also export the
searched event lists to a file.

| Learn about the Event Search Screen Configuration

W

Event search

0, XNV-6081Z,...

SOSPIA POPIODI3Y Y1 UDIeaS

Type D

s User [ (
[New [pefocusdetect. | xiv-60812(152..

New

Screen . .. q
No. ) . Detailed Description on Functions
Configuration
@ | Treetab You can see the list of camera, alarm input, alarm output, and POS.
@® | Search options You can search events by filtering by date or event type.
(3] Event list You can check the searched event results.
. You can check the details of the selected events in the event list or manage
O | Event details

the status of the events.
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| Search Event Logs
You can search the event logs or play the video recorded at the time of event occurrence.
1. Open the Search menu page.

2. Click the ] button to select Event search.

W

Event

XNF-8010R, XN

® You can also select the camera you want in the Alarm output, Alarm input, or POS tab.
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4. Select the base time at the moment when an event occurred.
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® Occurred (PC): You can search for the time when an event occurred based on the PC time.

® Occurred (Device): You can search for the time when an event occurred based on the device
time.

® Confirmed time: You can search for the search time based on the confirmed time of the event.
Confirmed time refers to the time when you confirmed through Confirm Events.

5. Set Start time and End time for search. Click the arrow in the date drop-down list to select the date
in the calendar that appears, and click the up/down arrows in the time scroll box to set the time.
You may also click the cell to enter the values directly.

6. If you want to search for specific events only, click the Event Type to select the event items to filter.

If you click the E button to the left of some events, you can select the detailed events of that
event.

(<IN BN < B< B< J< B< BN< By« |

Intru:
] Stentofon
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7. Click the Search button. The search results are displayed.

W

Event search o 0]

e

8. If you double-click the event you want to check in the Event list, then the video at the time of the
event occurrence is played in the Event details.

@ NOTE
A recorded video is only played in the Event details when there is the recorded video at the time of event
occurrence.
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| Confirm Events

When you select the event you want to confirm in the event search list, you can play the recorded
video at the time of the event occurrence. You can manage the event status after monitoring the
event video.

= [arson
(O]

-

A
S
~

1. Open the Search menu page.

2. Click the [l button to select Event search.

3. Select the desired camera, date and time range, and event type, and then search the event logs.
The event list appears.

4. Double-click the event you want to confirm in the event list. The video recorded at the time of
the event occurrence is played in the Event details to the right of the page.

5. Select the camera connected to the video of the occurred event.
6. Set Alarm type after checking the event video.

Alarm type: Normal, Abnormal, Others
7. Enter the event status values in Note.

8. Click the Confirmed button.
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@ NOTE
® When you click the History button, you can confirm the status and record of the event. In case you
have entered different event actions for each user on the same event, you can confirm the event
record through the event history.

Example: Suppose when the same event occurs, User A judges it as an intruder and writes the
intrusion route in the action details. On the other hand, User B inputs an additional description and
closes the situation. Details of this input process can be confirmed via History.

® The recorded video is played only when the camera video at the time of event occurrence is recorded.
® You cannot play the recorded videos from one camera on several menus at the same time.

Example: Recorded videos from Camera A cannot be played in the Instant viewer and Search menu
pages at the same time.

A

No. Status Type Device
Confirmed Motion Detection | PND

1 - 2019-11. -11-
Moton Detectan | PND-AS0B1RY - pTINTTE E——

102 | WISeNeT Wisenet SSM Console Client User Manual



| Play Event Videos Sequentially
You can play and monitor multiple event videos sequentially.
1. Open the Search menu page.

2. Click the ] button to select Event search.

3. Select the desired camera, date and time range, and event type, and then search the event logs.
The event list appears.
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@J NOTE
® Sequential playback of event videos is available after performing "Search event logs."
® For more information about searching the event logs, please refer to Search Event Logs.

4. Select the events you want for sequential playback in the search results list.
@ NOTE
You must select at least two events to use sequential playback.

5. Click the button in the search options. The recorded videos of the selected events are
played sequentially in the Event details.

No, Status Tipe Device

—F
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| Export Event Logs to a File
You can export the searched event results to a file.
1. Open the Search menu page.
2. Click the ] button to select Event search.

3. Select the desired camera, date and time range, and event type, and then search the event logs.
The event list appears.
For more information about searching the event logs, please refer to Search Event Logs.

4. Click the button in the search options.

Check 7| No. Status Type Device

-

5. Set the path to store the log files in the Export event log dialog box.

Export event log

Path |

6. Click the Export button. Log files support CSV file format only.
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Al Search

By connecting to an Al camera, you can play videos or search for images in various conditions such as
people, face, vehicle, vehicle number. You can also export the searched results to a file.

| Learn about the Al Search Screen Configuration
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PND-AS(
2020-04.

Screen . .
Number X . Detailed Feature Explanation
Configuration
You can set various search conditions, such as date, time, people, face,
vehicle, vehicle number, etc.
(1) Search Option . :Undo selected search parameters and reselect search parameters.
. Save selected search parameters.
« E&: You can select and apply a saved search condition list.
You can view the Search results.
- : You can view search results with thumbnails.
(2] Search Results - B You can view search results on a list.
« & : You can designate flags on the search results.
. . : You can save search results as a. jpg file.
Search results can be viewed as videos. Double-clicking the desired item
Search Results from the search results will playback the video recording, and you can
(3) Detailed confirm the section on the time line at which the video recording is located.
Information If you click the event list once, a static video image will be displayed in the

event details.
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| AlSearch

1. Open the Search menu page.

2. Click the ] button to select a search condition you want.

® Person search: You can select gender, clothing colors (tops and bottoms), and/or wearing
of a bag as search conditions.

® Face search: You can select gender, age, or whether to wear glasses/masks as search
conditions.

® Face recognition search: You can register a face image and select Similarity as a search
condition. See Face Recognition Search for detailed information.

® Vehicle search: A car's type, color, country, or license plate can be selected as search
conditions. (Country and license plate are supported as search conditions only for FFGroup
devices.)

® LPR search: You can select vehicle number as a search condition.

W

Vehicle search

PND-AS

3. Set the camera, date & time frame, and details you want to search.

® (lick the & button to undo selected search parameters and reselect search parameters.

@] NOTE
See below for LPR search:

® You can use a question mark (?) to represent one character in that exact position.
® You can use an asterisk (¥) to represent any number of characters/numbers in-between.

® You can mix question marks (?) and asterisks (*) to search.
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4. Click the Search button. The search results are then displayed as thumbnails.

¢ Click on the [E] button to view the search results as a list. Hover the cursor over the list to
view thumbnail images.

5. To view a search result, double-click the thumbnail or list item for the result. The selected video
recording will playback, and you can confirm the section on the time line at which the video
recording is located.
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| Save Search Parameters
1. Open the Search menu page.

2. Click the ] button to select a search condition you want.

® Person search: You can select gender, clothing colors (tops and bottoms), and/or wearing
of a bag as search conditions.

® Face search: You can select gender, age, or whether to wear glasses/masks as search
conditions.

® Vehicle search: A car's type, color, country, or license plate can be selected as search
conditions. (Country and license plate are supported as search conditions only for FFGroup
devices.)

® LPRsearch: You can select vehicle number as a search condition.
3. Set the camera, date & time frame, and details you want to search.
4. Click the g8] button to save the selected search parameters.
5. Select a name and click the OK button, and the list will be saved.

® Toview the stored search parameter list, click the E&] button.

® (licking the desired list from the stored search parameter list will repopulate the search
parameters and you can search again.

® You can view the search parameters by hovering the cursor on the list.

* Todelete alist, select the desired list and click the i button.
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| View Flagged List
1. Open the Search menu page.
2. Click the ] button to select a search condition you want.

® Person search: You can select gender, clothing colors (tops and bottoms), and/or wearing
of a bag as search conditions.

® Face search: You can select gender, age, or whether to wear glasses/masks as search
conditions.

® Face recognition search: You can register a face image and select Similarity as a search
condition.

® Vehicle search: A car's type, color, country, or license plate can be selected as search
conditions. (Country and license plate are supported as search conditions only for FFGroup
devices.)

SO3PIA PRPIODBY BY1 YDIRSS
]

® LPR search: You can select vehicle number as a search condition.
3. Set the camera, date & time frame, and details you want to search.

4. Click the Search button. The search results are then displayed as thumbnails.

@ NOTE
You can only set flags when viewing search results via thumbnails.

5. Hover the cursor over the desired image from the search results and click the [l button.
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6. To view only flagged results, click the [l button.

@ NOTE
The flagged results will be deleted if you search again.
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Search again with Bestshot

1. Open the Search menu page.
2. Click the [Jl] button to select a search condition you want.

® Person search: You can select gender, clothing colors (tops and bottoms), and/or wearing
of a bag as search conditions.
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® Face search: You can select gender, age, or whether to wear glasses/masks as search
conditions.

® Vehicle search: A car's type, color, country, or license plate can be selected as search
conditions. (Country and license plate are supported as search conditions only for FFGroup
devices.)

3. Setthe camera, date & time frame, and details you want to search.
4. Click the Search button. The search results are then displayed as thumbnails.

5. Hover the cursor over the most satisfactory image from the search results and click the [E}
button.

Object properties

6. Select the desired parameters, then click the Search button.

® You can add other parameters to the parameters of the selected bestshot and search again.
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| Face Recognition Search
Face recognition search is available only on devices authorized by a user.
1. Open the Search menu page.

2. Click the [fl] button and select Face recognition search.

W

Face recognition search

PRN-6410DB4_CHO05

Object properties

3. Set the camera, date, and time range to search.

4. Click Face.
A face image can be registered as a search condition. You can use face images registered from
your storage device and perform search in the Face library tab.

W

Face recognition search

PRN-6410DB4_CHO05
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5. Click the . button from the File tab. Select an image to be uploaded and click the Upload button.
Doing so will extract and display only the faces from the uploaded images.
Click a desired face (up to 5 faces) to register it as the face to be searched.
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Camera

Occurred (Device)

Object properties

6. Toregister a face image from storage devices as a search condition, select a desired face image
from the Face library tab.

W

Face recognition search

PRN-6410DB4_CHO05

Face library.

Group | GROUP1

Occurred (Device)

[LTre——

Search the Recorded Videos | 113



7. Set the face similarity.

W

Face recognition search

PRN-6410DB4_CHO05

00:00 ~
00:00

Similarity

—_— 1 w0 %

& button to clear the selected search condition and select one again.

8. Click the Search button. The search results will be displayed as thumbnails.

- RN
Face recognition search H F NETTIDBAG

PRN-6410DB4_CHO05

9. Double-click a thumbnail to check the search result. The selected video recording will be played
back, and the section of the video recording can be checked in the timeline.
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Search Audit Logs

You can search Audit logs from your device.

| Learn about the Audit Log Search Screen Configuration

W
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2]

Occurred (PC) 7| Confimed time Description

Audit log search

No. Status

Type Device User
start watching || XND-6081F2(17. | user2(17230.. [ 2020-121515: [ [startwatching ve video

Search

Totak: 165

No. S.creen . Detailed Description on Functions
Configuration
Tree tab Logs can be filtered by date or type for searching.

The column of the list can be configured or the searched logs can be

Search options .
P exported as a file.

Log list You can check the search results.
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| Search Audit Logs

1. Open the Search menu page.

2. Click the ] button and select Audit log search.

W

Audit log search

2020-12-15 00:00:00 ~
2020-12-15 16:00:00

3. Select the base time at the moment when an event occurred.

W

Audit log search

2020-12-15 00:00:00 ~
2020-12-15 16:00:00

® Occurred (PC): You can search for the time when an event occurred based on the PC time.

® Occurred (Device): You can search for the time when an event occurred based on the device
time.
4. Set Start time and End time for search. Click the arrow in the date drop-down list to select the
date in the calendar that appears, and click the up/down arrows in the time scroll box to set the
time. You may also click the cell to enter the values directly.

W

Audit log search
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5. To search a specific log, click Audit log type and select a filter.

ideo monitoring

Backup
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Connection status

6. Click the Search button. The search results are displayed.

W

Audit log search
Status 7 Confimed time 7

. T T T o ae
1 [vew | Stwatchngl | i0s0sir07. | sea172301.. | 2201215155 |- |ttt watchng e video

0-12-15 00:00:00 ~

User login

nfiguration)
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Advanced Search the Recorded Videos

You can search the camera videos recorded in SSM Core Server to check the event with motion or the
event passing by the virtual line on the video or coming in and out of the virtual area.

E] NOTE
® To search the recorded videos by date or event, you can check Playback mode in the Monitoring
menu. For more information, please refer to Search the Recorded Videos by Date or Search the
Recorded Videos by Event.

® Motion search and Smart search functions can be used on the recorded videos of one camera only..
You cannot use these functions to search multiple camera videos at the same time.

® Devices that do not support Motion search can use Thumbnail search.
® To use Smart search, all of the following conditions must be met:

— Ifthe camera setting is set to use IVA, or the camera does not support VA, Motion detection is set
instead of IVA;

— Hanwha Techwin's camera is registered as SUNAPI protocol on SSM Core Server; and

— The camera video must be recorded on SSM Core Server.

Open the Advanced Search Menu Page
1. Run SSM Console Client.
2. Enter your ID and password in the Login dialog box, and click the Login button.

3. Click the [+] button at the top left of the program, and then select Advanced Search in the Add
tab dialog box.

W Menitoring 1 +
Add tab

Monitaring

4 =
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Thumbnail Search

Thumbnail search menu enables you to use Motion search and Thumbnail search.

® Motion search: It displays the thumbnails at the time of the motion detection event at the set
search time interval.

® Thumbnail search: It displays the thumbnails at the set search time interval.

Q

NOTE

® Devices that support the motion detection will have Motion search activated in the search options.

® Devices that do not support Motion search can use Thumbnail search.
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| Learn about the Thumbnail Search Screen Configuration

PTZ  Bookmark

09:58:51

No. S'creen . Detailed Description on Functions
Configuration
You can set the search conditions (e.g., area, thumbnails display time interval, etc.)
for Motion search or Thumbnail search.
« Motion search: You can search a video recorded at the moment when a motion
detection event occurred. This is only available in DVR.
. + Select all: You can set the entire video on the video tile as a motion search area.
@ | Search options o ) )
This is only available in DVR.
« Deselect all: You can deselect all of the search areas set on the video tile. This is
only available in DVR.
« Search time interval: You can perform either Motion search or Thumbnail search
based on the time you have set.
@O | Timeline You can check the sections with recorded videos and set the time interval to search.
© | Searchresults When the search is complete, the search results are displayed as thumbnails.
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| Search Motion
1. Open the Advanced search menu page.
2. Select the desired camera from the camera tree in the Camera tab.

3. Select Motion search from search options.

If the selected camera does not support Motion search, then you cannot select Motion search.

4. Set the date and time range to perform a Motion search in the timeline. Use the time tooltip
on the timeline to change time settings. For more information, please refer to Set Search Time
Interval.

@ NOTE
The time range for Motion search can be set up to 1 hour (60 minutes).

5. Set a search area on the video.

(G
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® Setsearch area: You can select a search area by clicking the cells of the area to be searched
in the video tile or by clicking the top left cell of the search area and dragging to the bottom
right.

® Release selected area: You can release the selection by clicking the selected cells once
again. You may also deselect the area by dragging the mouse on the selected area.

® Set/Release the entire area: You can set or release the search area on the entire area with
the Select all or Deselect all button.
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Set the Search time interval. When no search time interval is set, the default value is applied.

# Motionsearch  [J1] | Selecta Jeselect a Search timeinterval 1 min

Click the Search button. Search results are displayed as thumbnails.

Select the desired thumbnails in Search results to check the search results. The video recorded
at the moment when a motion detection event occurred is played.

| Search Thumbnails

1.

2.

Q

5.

Open the Advanced search menu page.
Select the desired camera from the camera tree in the Camera tab.
Deselect the check box next to Motion search in search options.

Set the date and time range to perform a Thumbnail search in the timeline. Use the time
tooltip on the timeline to change time settings. For more information, please refer to Set Search
Time Interval.

NOTE

The time range for Thumbnail search can be set up to 1 hour (60 minutes).

Set the Search time interval.

Search time interval 1 min

6. Click the Search button. Search results are displayed as thumbnails.

7. Select the desired thumbnails in Search results to check the search results. The video recorded

at the selected time of search is played.
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Smart Search
You can search for the motion videos that match the conditions set for the recorded video at a specific time.

B Learn about Virtual Area

Once a search area is set on the video, it detects the motions of specific conditions such as
intrusion, enter, exit, appear (disappear), or loitering in the area.

B Learn about Exclude Area

It sets the area where the motion of specific conditions will not be detected on the video.

B Learn about Virtual Line

It detects the passing of an object based on the virtual line and direction set on the video.

| Learn about the Smart Search Screen Configuration

19:06:05
L

Screen
No. X . Detailed Description on Functions
Configuration

You can set the event search conditions for smart search.
. m: You can set the virtual area to search the motions of specific conditions.

© | Searchoptions | . m: You can set the exclude area where the smart search won't be performed
in virtual line or virtual area.

. : You can set the virtual line to search the motions of specific conditions.

o Timeline You can check the sections with recorded videos and set the time interval to
search.

Upon completion of the search, the search results are displayed as a list or

Search results .
© thumbnails.

122 | WISEeNeT Wisenet SSM Console Client User Manual



| Search Virtual Areas

1.

2.

Q

5.

Q

Open the Advanced search menu page.

Select the desired camera from the camera tree in the Camera tab.

In Search option, click the E] button and set the search area. Click the |#] button and set the
exclude area to set the area you do not want to search.

® Set the area on the video by selecting vertices on the video.. You can set 3 to 11 vertices.

® You can set up to 32 areas.
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® Right-click to complete the area settings.

When you set the area, the Virtual area dialog box appears. Set the event rules for detection,
and then click the Apply button. Click the Cancel button to delete the area you have set.

Virtual area

Enter
Exit

Motion Detection

NOTE

You can set several event rules in one area.

Set the date and time range for the virtual area search in the timeline. Use the time tooltip on
the timeline to change time settings. For more information, please refer to Set Search Time
Interval.

NOTE
You can set the time range for smart search up to 24 hours.
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6. Click the Search button. Search results are displayed in a list.

NOTE
@ Up to 500 search results are displayed per page, and you can use the < or B> button to move to another
page.

The following search result processing options are available:

Location Description

You can change how search results are displayed.
A - & displays the search results in a list.

- [l displays the search results as thumbnails.

You can view the search results by setting a filter to only show videos related to specific
events.

C You can save the searched information as an Excel file.

7. Select the desired items in Search results to check the search results. The video recorded at the
moment when an event occurred is played.
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| Search Virtual Lines
1.

2.

Q

Open the Advanced search menu page.

Select the desired camera from the camera tree in the Camera tab.

In Search option, click the - button and set a virtual line.
® Set a virtual line on the video by pointing the mouse cursor on the video.
® Right-click to complete the virtual line settings.

When you set a virtual line, the Virtual line dialog box appears. Set the Virtual line Direction
option, and then click the Apply button. Click the Cancel button to delete the virtual line you
have set.
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Virtual line

Direction

NOTE

If you select both options of the Virtual line direction, you can detect all objects that pass in both directions
on one virtual line.

5. Set the date and time range for the virtual line search in the timeline. Use the time tooltip on

Q

the timeline to change time settings. For more information, please refer to Set Search Time
Interval.

NOTE

You can set the time range for smart search up to 24 hours.

6. Click the Search button. Search results are displayed in a list.

7. Select the desired items in Search results to check the search results. The video recorded at the

moment when an event occurred is played.
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Set Search Time Interval

When you use the search functions, you can set the date and time range for the search on the timeline.

06:00:00 18:00:00

Screen

Location X . Detailed Description on Functions
Configuration

A Search date You can select the date to search.

Search start time

B . You can select search start time and end time.
and end time

You can set the search start time by moving the time display tooltip to the
left or right. If the tooltip of the search start time is moved to the left while

B-1 Search start time Lo . . . L
the time interval is set to maximum searchable time, then the entire time
interval will move.

You can set the search end time by moving the time display tooltip to
. the left or right. If the tooltip of the search end time is moved to the right
B-2 Search end time 9 P 9

while the time interval is set to maximum searchable time, the entire time
interval will move.
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Monitor POS Videos

POS system connected to NVR or DVR can be linked with SSM to configure the store management
system. You can monitor the sales records received from POS and the video at the time of sales at
the store in real time. In addition, you can search POS data using a specific text to check the recorded
videos and sales records at the time of sales.

NOTE
E] ® Tolinka POS system from SSM, you must register the storage device in SSM Core Server after
connecting the POS device to NVR or DVR.

® Please check the model specifications to see if the POS device is compatible with the storage device.

Open POS Menu Page

1. Run SSM Console Client.

2. Enter your ID and password in the Login dialog box, and click the Login button.

3. Click the [+] button at the top left of the program, and then select POS in the Add tab dialog box.

W\ Moenitoring 1 +
Add tab

Manitoring

3010R(192!
XNP-6320(192
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Learn about the POS Menu Screen Configuration

The POS menu screen is configured as follows:

PRN-4011_Epos001

)
[ RECEIPT )

POS / 9876511112 Gildol Hong / 02 21099314

Customer contact: 1000

Order Number: 1000FAQS020016

2 [ITEM] salt [COST] 2000 [cosT] o

cash (€OST] Supply value [COST]
o VAT 0

Credt

Text
2 u @

4
5
6

18:00:00
PLAYBAGK

Screen . s . q
No. X . Detailed Description on Functions
Configuration
(1) Search options You can input text to search from POS data.
(2] Device list You can see a list of cameras with linked storage device and POS device.
(3] Video window You can see the Live videos and POS search videos of the selected camera.
o You can check the sections with recorded videos and set the time interval
(4] Timeline
to search.
(5 Search results You can see the POS search results.
You can see the POS sales records received in real time and sales records of
(6) POS data
the searched results.
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Monitor POS Live Videos

You can monitor sales records and camera videos received from a POS device in real time.

NOTE
E] ® Sales records display only the information received from the POS device connected to NVR.

® DVR can monitor real-time videos of the cameras linked with a POS device, but it cannot check sales
records.

1. Open the POS menu page.

2. Double-click the desired camera from the POS tab. You may also select the desired camera in the
POS tab and drag it on the tile of the video window.

3. Whenever a sales record occurs in a POS device linked with the camera, the sales record appears in
the POS data.
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Search POS Data

You can search POS data to see the recorded videos at the time of sales.
1. Open the POS menu page.

2. Double-click the desired camera from the POS tab. You may also select the desired camera in the
POS tab and drag it on the tile of the video window.

3. Clickthe button to the right of the timeline to switch to Playback mode.
4. Enter a keyword in the search window. You can choose one of following search options:

® Match whole words: Only data that matches all characters, including whitespaces, are
displayed as search results. If this option is not selected, then whitespace is recognized as "OR".
(This returns all the results, even if only one of the words separated by whitespaces is satisfied.)

Example
Match Whole Words
Sales Record Search Word
Selected Unselected
Banana 3,000 Cash 8,000 Searched Searched
Apple 5,000
Total 8,000 i
Cash 5,000 Not searched ?earct\ed (1 instance of

Cash 8,000 Cash" matches)

® Match case sensitivity: When you enter a keyword in English, the search is case-sensitive.

@ NOTE
Keywords can be up to 127 characters long.

5. Click the Search button.

6. You can see the search results in the search list to the right. Select the desired items in the search
list.

® (lick the item to playback the video channels connected to the POS.

® (licking P plays the video recorded at the moment when a POS event occurred.

NOTE
@ When the playing video is controlled (stopped, played, paused, or played in fast forward), the sales record
at the time of recording appears in the POS data.
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Monitor System with Dashboard

You can monitor the status of the SSM Core Server system with SSM Console Client or a web viewer.

Open the Dashboard Menu Page
1. Run SSM Console Client.
2. Enter your ID and password in the Login dialog box, and click the Login button.

3. Click the [+] button at the top left of the program, and then select Dashboard in the Add tab
dialog box.

W Monitoring 1 =+
Add tab

Manitoring

hboard

Configuration

NOTE
E] ® You can monitor the dashboard remotely by typing the following address in your browser:
- Address: http://serverlP:9999/webadmin/index.html
— lItis available in Chrome browser.

® The dashboard only supports the English language.
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Learn about the Dashboard Screen Configuration

The dashboard screen is configured as follows:

15.68 0 Camera SsM server Recorder

AL DEVICE  NETWORKTRAFFI

i
L
J00PM  400PM  GOOPM  SOOPM  I00OPM  1:00AM  200AM  400AM  GOOAM  GOOAM  IOOAM  IZ0OPM  200PM  400PM  GOOPM

e -

Screen

Number ) ., Detailed description of function
configuration

You can check the quantity of registered devices.

« Camera: The number of cameras registered with all servers and recorders
(1] Device quantity within the domain and recorders

+ SSM Server: The number of servers clustered

+ Recorder: The number of recorders registered under the domain

You can check the network traffic of the system.
(2] Network traffic « System in: The sum of incoming camera video traffic to each server
- System out: The sum of video traffic coming from each server to the client

You can check the ratio of malfunctioning state to the total quantity of the
registered devices.

. Click this button to move to SSM Server page.

. Click this button to move to Recorder page.

(3] Device status
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Status history
graph

You can check errors from registered devices and network traffic status.

When moused over the graph, the number of errors at that point in time and

the network traffic status of up to last 7 days are displayed. You can use the

mouse wheel over the timeline to zoom in or out on the time scale.

+ ALL: Displays both the number of errors per device and the network traffic
status.

« DEVICE: Displays the number of errors per device.
(Camera/Server/Recorder)

« NETWORK TRAFFIC: Displays input/output traffic of the server.

List of logged-in
users

You can check the IDs of logged-in users. When moused over, their IDs and [P
addresses are displayed.

o a

The functions listed below can be used by clicking the e button.

. Q Link URL : The URL of the current page can be copied to and checked
on a web browser.

. @ Reports : The information of the current page (Home screen) can be
captured and exported as a PDF file.

. @ Logout : You can log out when monitoring Dashboard on a web
browser.

@ NOTE
All data is updated every minute.
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Checking the SSM Server page

Total 6 9

SSM Server

172.30.1.48 9999

N

6

No Data

(Raid Disk)

1.04. 0.58. 14.5... 0

ondiog

o

PNVASOBL- ID® - PNVASOSL-ID© - XNDS0SIFZ ID@ - DO - WFHIR DO - NP0 DO -

* &

Screen . N q
Number : . Detailed description of function
configuration

(1) Can move to the Home screen of Dashboard.
You can check the list of registered SSM servers and connection status.
In the status bar of each server, the number of malfunctioning cameras out

(2] Server list of all cameras registered with the server is displayed. When moused over,
you can check the number based on the number of connected cameras.
- Server that is not connected is displayed in red.

. You can check the details of your server. Click the server you want from the

(3] Server details :
server list.
Clicking this button lets you check the details such as camera list
and connection status.
. -HI : You can check the sorting criteria of the list. The selected

sorting criterion is displayed in orange.
(4] Camera list - 'z Camera connection status

~ Bl Dual recording action status
— [l Secure connection status
. . : You can sort the list by camera name.
« Search: Camera name can be filtered and displayed.
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The functions listed below can be used by clicking the e button.
. Q Link URL : The URL of the current page can be copied to and checked
on a web browser.
. @ Reports : The list including the latest information of all the SSM Server
in a domain can be exported as a CSV file.
— With SSM Console Client : You can set the file location and name to
save.
— With browser : You can download it in the default download folder of
the user who logged in to Windows.
. G Debug : The live logs of System Manager and Media Server can be
exported as a file.
— With SSM Console Client : You can set the file location and name to
save.
— With browser : You can download it in the default download folder of
the user who logged in to Windows.

. @ Logout : You can log out when monitoring Dashboard on a web
browser.
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Checking the Recorders page

e (3]

PRN-6410DB4

172.30.1.193 No Data

(Disk)

0@ - PRN-GAID-I0@ - P

PRN-6410D: PRN.SAL0D-- ~ — -

Number S.creen . Detailed description of function
configuration

(1) Can move to the Home screen of Dashboard.

You can check the list of registered recorders.

« When moved to the Recorders page for the first time, only the recorders

(2] Recorder list under System Manager accessed by the dashboard are displayed.

+ Any recorders not connected are displayed in red. SNMP connection
failure is displayed in yellow,

o Load You can check all recorders within the domain.
. Search: Recorder name can be filtered and displayed.

You can check the details of a recorder. Select the recorder you want from

Recorder details
o the recorder list.

Clicking this button lets you check the details such as camera list
and connection status.

You can check the sorting criteria of the list. The selected
sorting criterion is displayed in orange.

(5] Camera list ~ Bl camera connection status

Dual recording action status

Secure connection status

. . ou can sort the list by camera name.

« Search: Camera name can be filtered and displayed.
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The functions listed below can be used by clicking the e button.
. Q Link URL : The URL of the current page can be copied to and checked
on a web browser.
. @ Reports : You can export the list including the latest information of all
the recorders in a domain as a CSV file.
— With SSM Console Client : You can set the file location and name to
save.
—  With browser : You can download it in the default download folder of
the user who logged in to Windows.

. @ Logout : You can log out when monitoring Dashboard on a web
browser.
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Set Console Client

You can specify general settings, screen, and settings related to events on the Settings screen of the
console client.

Open Setup Page
1. Run SSM Console Client.

2. Enter your ID and password in the Login dialog box, and click the Login button.

3. Click the . button at the top right of the program.

Setup
General  Displa
Language English
Date/Time Yyyy-MM-dd hh:mm:ss
Startup option [ Auto-start on Windows startup
[ View full screen (¥ Load last settings
Screen lock / Log out ® Screenlock © Logout Off

Streaming protocol Multicast @ Unicast

System Controller off Disconnected
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Set General

You can set the general usage environment of SSM Console Client, such as Language, Date/Time,
Start options, and Video protocol type.

1. Open the Setup menu page.

1U31|D 3J0SUOY) 195

2. Click the General tab at the top left. You can set the following items.

Setup

General

Language

Date/Time

Startup option

Screen lock / Log out

Streaming protocol

@00 OO0

System Controller

English
yyyy-MM-dd hh:mm:ss
Auto-start on Windows startup

View full screen [V Load last settings

® Saeenlock  Logout  Off

Multicast @ Unicast

off Disconnected

No. Setup Items Description
@ | Language You can set the language of the system.

You can set the date and time format displayed in the OSD.
@ | Date/Time - Date format: yyyy (Year), MM (Month), dd (Day)

- Time format: hh (Hour), mm (Minute), ss (Second)

© | Startup option

You can set the screen display method when you start the program.

+ Auto-start on Windows startup: You can run the program automatically
when you start Windows.

+ View full screen: When you start the program, you can view the SSM
Console Client in full screen.

« Load last settings: You can display the last used menu on the start screen.
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No.

Setup Items

Description

Screen lock/
Log out

+ Screen lock: For security purposes, you can block the use of the program
when there is no keyboard or mouse activity for a specified period of time.
+ Log out: For security purposes, you can log out of SSM Console Client
when there is no keyboard or mouse activity for a specified period of time.
+ Time settings: You can click the drop-down list to set the base time to run
screen lock or log out. You can set one of the following options:
- Off: You don't use screen lock or log out functions.
- 5 min/10 min/15 min: After a set period of time, the screen lock or log
out is activated.

Streaming Protocol

You can choose between multicast or unicast when transmitting videos from
the SSM Core Server to the SSM Console Client.

To use multicast, set multicast to SSM Server at the following path.
Configuration > Device > Registration > Camera information > Profile

System Controller

You can set the controller for SSM Console Client.
« Supporting controllers
[Techwin] SPC-2000, SPC-7000
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Set Display

You can set the OSD information to be displayed on the camera tab and video tile.

1. Open the Setup menu page.
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2. Click the Display tab at the top left. You can set the following items.

Display

Show tree

05D text

Use device name
V| Device IP address

Date/Time Information icon
Meta data

Fontsize Middle

0SD position  Top left

Show IVA (Intelligent Video Analytics) rules

Enable mini map Location Top right
Live Video Masking (Beta) None

Masking Scale(WxH) 1 X 1

W] Camera name Show 1P

Size Small

Blur

No. Setup Items Description
+ Use device name: Displays the name set by the device in the Device list on
the Camera tab and in the video tile (e.g. Camera 01, Alarm 01, ...). If you
@ | Showtree deselect it, the name registered by configuration manager is displayed.

- Device IP address: Displays the IP information of the device in the Device

list on the Camera tab.
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No. Setup Items

Description

® | OSDtext

You can display the following items on the video tile.

- Date/Time: You can display date and time on the video tile. Cameras
registered in SSM Core Server display the date and time of SSM Core
Server, and cameras registered in DVR or NVR display the date and time of
DVR or NVR devices.

+ Information icon: You can display items such as recording status, PTZ
support as icons below the video tile.

- Camera name: You can display the camera name at the top left of the
video tile.

« Show IP: Device IP information can be displayed on the video tiles.

- Metadata: You can display the IVA detection result received from the
camera as a green square on the video tile. Metadata refers to the IVA
detection result data.

« Font size: Click the dropdown menu to configure the font size of the OSD
information. You can select Custom to set to a desired size.

« OSD position: Click the dropdown menu to configure the position of the
OSD information.

© | ShowOsD

- Show IVA (Intelligent Video Analytics) rules: You can display the IVA
rules set by the camera on the video.

«+ Enable mini map: When you double-click the map link icon on the map
layout, you can display a mini map over the current map rather than move
to that map layout. You can set the location and the size of the mini map
by clicking the drop-down menu.

« Live Video Masking (Beta): You can enable masking (Blur/Mosaic/
Fisheye) to protect the privacy of people who show up in videos in order
to make them unidentifiable.

« Masking Scale(WxH): You can set the size of image masking.
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Set Video

You can set monitoring, quality and protocol type of the video played, capture, recording path, etc.

1. Open the Setup menu page.
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2. Click the Video tab at the top left. You can specify the following event setup items.

Video

Video display optimization

Video quality

Enable decoder

Event

® Auto Manual

V| Anti-aliasing

V| Enable streaming buffer

V| Aspect ratio
Blodk video(s) streamed from other camera(s) when viewing a video from a camera in full soreen mode
Enable NVIDIA CUDA Decoder
Enable Intel Quick Sync Decoder

path  C:\Users\Public\Documents\Wisenet\SSM\Capture _ Open details

Path C:\Users\Public\Documents\Wisenet\SSM\Record _ Open details

Recording time 10 min

Enable the login password as a password for
recording

T T

Format AVI ® SEC Enable digital signature

No. Setup Items

Description

Video display
optimization

+ Auto : You can automatically display images in low or high resolution based on
the monitor resolution, image tile size, or system load.
- Manual : You can set the following options for monitoring and playback video
quality.
- Only I-frames are played when decoding or rendering loads occur:
You can set to play only I-frames if degraded decoding and rendering
performance occur due to system overload.
- You can set a split screen to play only I-frame by clicking the dropdown
menu.
- You can set to output a high resolution profile video when the size of the
video tile is larger than the set value.
Preview button enables you to check the size of minimum video tile that
can be viewed in a high resolution profile.
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No. Setup Items

Description

® | Video quality

Anti-aliasing: You can improve the aliasing phenomenon where pixels look
jagged when playing a video in SSM Console Client. Using anti-aliasing will
improve the quality of the video, but it can cause streaming to stop.

Enable streaming buffer: You can play video evenly when a video delay occurs
due to network and other usage environment issues. Streaming buffer allows
for more uniform video playback, but the streaming can be delayed.

Aspect ratio: You can zoom in or out on the video screen to view videos by
the size of the tiles while maintaining the aspect ratio of the camera video
resolution.

Block video(s) streamed from other camera(s) when viewing a video from

a camera in full screen mode: This function is intended to prevent network
overload. You can pause receiving the camera video of the remaining
monitoring channels when viewing a specific channel in full screen during
multi-channel monitoring.

Selecting this function may prevent network overload, but switching from
1-channel video in full-screen to multi-channel monitoring screen prolong the
time it takes to receive the whole video.

Enable
decoder

Enable NVIDIA CUDA Decoder: When a hardware decoder (NVIDIA's CUDA
Decoder) is separately installed in the PC, the corresponding decoder can be
used as a video decoder for SSM.

Enable Intel Quick Sync Decoder: When a hardware decoder (Intel's Quick
Sync Decoder) is separately installed on the PC, the corresponding decoder can
be used as a video decoder for SSM.

O | Capture

You can Capture the video of the tile and set a path to save as an image file.

Open details: When you click the Capture button, the Capture dialog box
appears. You can set the storage path and the information to be displayed on
the image.

@ | Record

When you store the video of a tile in your local PC, you can set the file path to
save to, time, format, etc.

Path: You can set the path to record on your PC.

Open details: If you click the Local recording button, a dialog box appears to

set the recording path.

Recording time: You can set the recording time to record on your PC.

— Setup time: 1 to 60 minutes (It can be setin 1 minute intervals.)

Format: You can set the recording file format to AVI or SEC.

— AVI: You can save the local recording videos using the AVI extension. AVI
files can be played in normal video playback programs used on the PC.

— SEC: You can save the local recording videos using the SEC extension. When
you record as a SEC file, you can play the exported file in Backup viewer,
which is a video playback program for SEC files only.

Enable the login password as a password for recording: You can set to enable

playback only if the login password is entered when you play the video. You

can make additional settings when selecting the SEC file format.

Enable digital signature: You can record videos by applying a digital signature

to verify video forgery or falsification. You can make additional settings when

selecting the SEC file format.
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Set Events

You can set the usage environment for the event that occurred.

1. Open the Setup menu page.
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2. Click the Event tab at the top left. You can set the following items.

Video | Event

Show tile upon event occurrence

Playback time for event

Event spot

Instant viewer

Map layout

| Enable 10s

Event pre playback time 30s

Event post playback time 30 s

Display Target Event

Display Time  Continuously

V| Open instant viewer when event has occurred.

Maximum number of instant viewers 1

Pop-up duration Continuoushy

New event discard time Continuously
Pop-up location Monitor 1
Link map to event

Show map with active event

No. Setup Items Description
P Show tile upon You can set whether or not to play the video of an event when the event
event occurrence occurs and its play duration.
. When playing an event video in the Instant viewer or Event menu, you can
Playback time for . .
(2] event set the event playback time to include a set number of seconds before or
after the event occurrence.
When using the event spot function, you can configure the event details and
© | Eventspot

display time to be displayed.
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No. Setup Items

Description

O | Instant viewer

You can set whether to use the Instant viewer when an event occurs.

« Maximum number of instant viewers: You can set the maximum number
of the Instant viewers to display. You can set up to 3 Instant viewers.

« Pop-up duration: You can set the display time for how long the Instant
viewer is displayed when an event occurs. After the set time, the Instant
viewer closes automatically.

- New event discard time: When the same event occurs from the same
camera within the time set for the Instant viewer displayed, you can set
the Instant viewer so that it does not display new events.

« Pop-up location: You can set a monitor to display the Instant viewer when
configuring the monitoring screen using multiple monitors.

© | Map layout

When monitoring with a map layout in Monitoring menu, you can set

actions when an event occurs.

+ Link map to event: When an event occurs on the map link icon, you can
set it to switch to that map layout.

- Show map with active event: You can display the map link icon where the
event occurred in the center of the screen.

146 | WISEeNeT Wisenet SSM Console Client User Manual



Appendix

System Requirements

| SSM Core Server

Minimum Specifications

Recommended Specifications

Intel Core i7 or more (i7-4770@3.40GHz)

Q

CPU Intel Core i5 or more (i5-4670@3.40GHz)
Xeon E3-1275 v5 (8M Cache 3.6 GHz)
RAM 8 GB or more 16 GB or more
Windows 8.1/10 (Pro, Enterprise)
Windows 10 |OT Enterprise
Windows Server 2008 SP2/2008 R2 SP1 (Standard)
os Windows Server 2012/2012 R2 (Standard)
Windows Server 2016 (Standard)
Windows Server 2019 (Standard)
Windows Server 2019 Essential
* Can be installed on 64-bit OS only.
Operating System HDD Operating System HDD
+ SSD recommended + SSD recommended
« 20 GB or more free disk space is required + 20 GB or more free disk space is required
after OS and SSM Core installation after OS and SSM Core installation
Camera Video Recording HDD Camera Video Recording HDD
+ Requires separate HDD for recording + Requires separate HDD for recording
HDD (Requires a minimum of 200 GB for (Requires a minimum of 200 GB for
logging) logging)
« HDD: SATA3 7200 rpm (64 MB Cache) - HDD: 4 SATA3 7200 rpm (64 MB Cache) or
« NIC Bandwidth 1 Gbps or more more
« NIC Bandwidth 1 Gbps or more
« RAID, iSCSI support: RAID5, HW RAID
Controller (AF support)
NOTE

SSM 2.10.8 or later requires a separate HDD, other than the C drive, for event recording and searches.
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| SSM Console Client

Minimum Specifications

Recommended Specifications

Intel Core i7 or above (i7-4770@3.40GHz)

CPU Intel Core i5 or above (i5-4670@3.40GHz)
Xeon E3-1275 v5 (8M Cache 3.6 GHz)
+ When using CUDA H/W Decoder
Geforce GTX 740 (1 GB RAM) Geforce GTX960 (RAM 2GB) or more
GeF GTX1 RAM 2GB
VGA 6th gen. Intel Processor Graphics ? oree 050( ) or more
) DirectX 11
Supports DirectX 11 - When using Intel Quick Sync H/W
HD Graphics P530 or above
RAM 8 GB or more 16 GB or more
Windows 8.1/10 (Pro, Enterprise)
os Windows 10 |OT Enterprise
* Can be installed on 64-bit OS only.
HDD 20 GB or more free disk space is required after OS and SSM Console Client installation

Product Specifications

System

Max Monitoring

Max 10,000 channels/domain

Max 3,000 channels/server

In case of using camera/NVR/DVR

Channels * Camera registration: Max 328 channels
Camera recording: Max 128 channels
Max 3,584 channels/domain
Max 128 channels/server
Max 520 Mb
Max Storage ax ps .
Channels Supports dual recording (High/Low) In case of using server storage
* The maximum recording performance
varies depending on the specs of
HDD, H/W RAID, and iSCSI.
Soft
ortware Server/Client Multi-server clustering, max 28 servers
Structure
S t to 35 simult ti
Client Console client, mobile viewer upports up to 3> simultaneous connections per
server
Supports Wisenet products + ONVIF Profile S
Supported Network camera/encoder/decoder, O .
Devices DVR/NVR, controller NVIF 1 ©

ONVIF® conformant (www.onvif.org)
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Basic Component

Central license management

45-day trial

Server clustering

Server data sharing, failure management

System dashboard

Real-time system health monitoring

User management

Device access permission, function access
authorization

SSM Core Server Federation Multi-domain federation, up to 10 domains
. Automatic/Manual registration of devices and

Central device setup -,
additional servers
4-step importance setting, color management b

Event setup pImp J 9 y
event

Event action Event users setup and trigger activities

Layouts and patterns Custom layouts and tile patterns

i Monitoring, Search, Advanced search, ANPR, POS,

Tab-based windows ) .
Dashboard, Configuration, Setup

Output channels Max 132 channels

. Supports hardware accelerator
Decodin
' (CUDA, Intel Quick Sync)
SSM Console | Playback Multi-channel playback, bookmark
Client Real-time events Filters by situation, type, and importance

Event search, Person search, Face search, Face

Search recognition search, Vehicle search, LPR search,
Audit log search

Advanced search Thumbnail search, Smart search

POS text search Searches receipt list, keywords

Korean, English, Chinese, Croatian, Czech, Danish, Dutch, Finnish, French, German, Greek,

Supported . . . . . . .
Hungarian, Italian, Japanese, Norwegian, Polish, Portuguese, Romanian, Russian, Serbian,
Languages

Spanish, Taiwanese, Thai, Turkish, Arabic, Ukrainian, Vietnamese
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Service Ports

Please see the list of ports used by Wisenet SSM.

System Manager

9991, 9999, 61616, 9876

SSL(9991)

TCP for Web Service(9999)
Active MQ(61616)
PostgreSQL(9876)

Media Server

4510-4517

TCP(4510,4511)
SSL(4512,4513)
HTTP(4514)
RTSP(4515,4516,4517)
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Supported Devices

Please see the list of supported products.

| DVR

H 4-channel

HRX-421FN/TE, HRX-420, HRX-421, HRD-440, HRD-442, SRD-493, SRD-494, SRD-443, SRD-473D,
SRD-476D, SRD-482, SRD-445, SRD-470, SRD-440

H 8-channel

HRX-821/TE, HRX-820, HRX-821, HRD-842, HRD-841, SRD-893, SRD-894, SRD-840, SRD-482,
SRD-852D, SRD-870DC, SRD-873D, SRD-876D, SRD-880D

m 16-channel

HRX-1621/TE, HRX-1620, HRX-1621, HRD-1642, HRD-1641, SRD-1685, SRD-1694(U), SRD-1684,
SRD-1630(D), SRD-1640, SRD-1642(D), SRD-1653D, SRD-1654D, SRD-1656D, SRD-1673D,
SRD-1676D, SRD-1680D, SRD-1673DU

| NVR

PRN-6410DB4, PRN-6410B4, PRN-3210B4, XRN-6410DB4, XRN-6410B4, XRN-3210B4, QRN-1620S,
QRN-820S, QRN-420S, LRN-1610S, LRN-810S, LRN-410S, XRN-1610SA, XRN-1610A, XRN-2010A,
XRN-2011A, XRN-3010A, QRN-410S, KRN-3200, KRN-1600, QRN-810, XRN-810S, QRN-410,
XRN-410S, XRN-820S, XRN-1610(S), XRN-1620B2, XRN-1620SB1, XRN-2010/2011, XRN-3010,
PRN-4011, SRN-4000, SRN-1000, SRN-1670D, SRN-470D, SRN-16735/8735/473S, SRN-472S,
VPM-4800/4400/5400/6400

| NETWORK CAMERA

m BOX

QNB-6002, QNB-8002, TNB-9000, PNB-A9001, XNB-8002, XNB-9002, XNZ-6320, QNB-6000,
XNB-6001, QNB-7010RH, QNB-7080RH, XNB-6005, XNB-6001, KNB-5000, KNB-2000, XNB-8000,
XNB-6000, SNB-9000, SNB-8000, SNB-5000, SNB-6005, SNB-7004, SNB-6004(F), SNB-5004,
SNB-6003, SNB-5003, SNB-3002, SNB-7001, SNB-5001, SNB-1001, SNB-6010(B),SNB-6011B,
SNZ-6320, SNZ-5200

m DOME

TNV-8010C, PND-A9081RV/RF, PNV-A9081R, XND-6081RVE, XND-6081RE, XND-8081RVE,
XND-8081RE, XNV-9082R,XND-9082RV, XND-9082RF, XNV-8082R, XND-8082RV, XND-8082RF,
XND-6080RG, QNE-7080RV, XNV-8080RS, XNV-6085, XND-6085, XND-K6080, QNE-6080RV,
QNE-6080RVW, QNE-7080RVW, QNE-7080RVW, XNV-6012, XNV-6012M, XNV-6013M,
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XNV-6022R, XNV-6022RM, XND-6085V, XNV-8030R, XNV-8040R, KND-5080R, KND-5020R,
KND-4080R, KND-4010R, KND-2080R, KND-2020R, XND-6020R, XNV-6120, XNV-6011,
XNV-8040R, SNV-8030R, XNV-8020R, XND-8040R, XND-8030R, XND-8020R, XNV-6020R,
XNV-6010, XND-6010, XND-6080RV, XND-6080RV, XND-6080(R)(V), XNV-6080(R),
XNV-8080(R)(RV), XND-8080R, XNV-6120R, PNV-9080R, PNM-9020V, PND-9080R, QND-7080R,
QNV-7080R, QND-7020R, QND-7010R, QND-6010R, QND-6020R, QND-6030R, QNV-7020R,
QNV-6010R, QND-6070R, QNV-6070R, QNV-7010R, QNV-7020R, QNV-7030R, SNV-L6013R,
SNV-L6014RM, SNV-6085R, SNV-8081R, SNV-7084R, SNV-6084R, SNV-L6013R, SND-L6083R,
SND-L6013R, SND-6012, SND-7084R

m FISHEYE

XNF-9010RS, XNF-9010RV, XNF-9010RVM, QNF-9010, XNF-8010, XNF-8010RV, XNF-8010R,
PNF-9010R(RV)(RVM), SNF-8010(VM), SNF-7010

B MULTI-SENSOR

PNM-9322VQP, PNM-9320VQP, PNM-9081VQ, PNM-9080VQ, PNM-9030V, PNM-9022V,
PNM-9020V, PNM-9002VQ, PNM-9000VQ, PNM-9000QB, PNM-8082VT, PNM-7002VD,
PNM-7000VD

H BULLET

XNO-6085RA, XNO-L6085RA, XNO-L6085R, PNO-A9081R, XNO-8082R, XNO-9082R, XNO-L6120R,
XNO-6120RG, XNO-6085RG, XNO-L6020R, XNO-6080RA, XNO-6080RG,XNO-L6080R,
XNO-6090RH, XNO-6095RH, XNO-6080RG, XNO-6085R, KNO-5080R, KNO-5020R, KNO-4080R,
KNO-4010R, KNO-2120R, KNO-2080R, KNO-2010R, XNO-8020R, XNO-8030R, XNO-8040R,
XNO-8080R, XNO-6080R, XNO-6010R, XNO-6020R, XNO-6120R, QNO-7080R, QNO-7030R,
QNO-7020R, QNO-7010R, QNO-6010R, QNO-6020R, QNO-6070R, QNO-6030R, PNO-9080R,
SNO-8081R, SNO-7084R, SNO-6084R, SNO-6011R, SNO-5084R, SNO-5080R, SNO-L6083R,
SNO-L6013R, SNO-L5083R, SNO-6085R, TNU-6320E, TNO-6320E, TNO-6322ER

m PTZ

XNP-9300RW, XNP-9300R, XNP-9300, XNP-8300RW, XNP-8300R, XNP-8300, XNP-6400RW,
XNP-6400R, XNP-6400, XNP-6321H, XNP-6321, XNP-6320HG, XNP-6370RHA, XNP-6320H,
XNP-6320, XNP-6320HS, XNP-6370H, XNP-6040H, XNP-6120H, XNP-6370RH, XNZ-6320,
XNP-6550RH, XNP-6371RH, XNP-6371RHG, XNP-6370RH, PNP-9200RH, SNP-6321(H),
SNP-L6233(H)(RH), SNP-L5233(H), SNP-6320(H)(RH), SNP-6230(RH), SNP-5430(H), SNP-3302(H),
SNP-3371(H)(TH), SNP-5300(H), SNP-5321(H), SNP-5430(H), SNP-6200RH, SNP-6201(H),
SNP-3120(VH)

m POSITIONING
TNU-4051T, TNU-6320, TNU-6320E, TNU-6321

m THERMAL

TNM-3620TDY, TNO-4051T, TNO-4041TR, TNO-4040TR, TNO-4030TR, TNO-4030T, TNB-1080T,
TNB-1050T, TNB-1040T, TNO-1030T
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| ENCODER
SPE-400/100/101, SPE-1600R, SPE-1610/410

| DECODER

SPD-1660R

| SENSOR

B Advantech's Extended I/O0

ADAM-6050: Sensor x12, AlarmOut x6
ADAM-6060: Sensor x6, AlarmOut x6
ADAM-6066: Sensor x6, AlarmQOut x6

B MOXA's Extended I/0
NA-4010 (Sensor: M-1601 (16-channel), AlarmQOut: M-2601 (16-channel))

m ONVIF

ONVIF compatible camera

Camera supporting ONVIF 1.02 or later (Compatible with Prole-S)
Video codec: MJPEG, MPEG4, H.264, H.265

Audio codec: G.711(pcm ulaw), G726, AAC

| INTERCOM

TID-600R
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Use System Controller

You can check the connection settings and connection status in SSM Console Client > [ > General >

System Controller.

| SPC-2000

The SPC-2000 joystick is operated as follows:

® SPC-2000 must be connected to the PC before the console is launched in order to be

recognized.

® SPC-2000 can run in PTZ or Screen mode.

® In Screen mode, the layouts assigned to the console are numbered 1~8 in the order of

assignment.
M B
2
3
Name Function
« In PTZ mode, the camera can be panned, tilted, and controlled in 8
Up/Down/Left/Right directions.
1) + In Screen mode, the top/bottom/left/right tile can be selected.
. In PTZ mode, the screen is zoomed in when it is rotated clockwise and
Rotation . .
zoomed out when it is rotated counterclockwise.
« In PTZ mode, presets number 1~8 are run.
2 |1~8 + In Screen mode, the layout corresponding to the button number is
run.
(3] [9~10 PTZ mode and Screen mode are switched.
+ In PTZ mode, Focus Near/Far operation is run.
@ (11,12 . .
+ In Screen mode, multiple monitors can be selected and changed.
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[E’ NOTE
To set the correct image, the axis calibration is needed.
Select ﬂ > Set > Control Panel > Game Controller > Property > Set via the PC, click the
Compensation button to run the System Compensation Wizard and then follow the guide on the

screen to complete axis compensation.

| SPC-7000
The operating specifications with SPC-7000 joystick connected are as follows.

® SPC-7000 displays each operating status of the system controller on the LCD monitor, and
allows the user to easily select a menu with a touch screen, or using a joystick.

® |t operates in the following 5 modes; PTZ/Screen/Mouse/Console/VM

xipuaddy
]

+ In PTZ mode, you can control the Pan and Tilt
motion.

In Screen mode, you can change the Up/Down/Left/
Right tile selection.

(1) | Joystick « In Mouse mode, you can move the mouse cursor.

Up/Down/Left/Right

In PTZ mode, the screen zooms in when turning in the
Rotation WIDE direction, and zooms out when turning in the
TELE direction.
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Name

Function

[FOCUS N/F] + Runs the Focus Near/Far motion.
- [FOCUS N/F] + Bl : Focus Near
[FOCUS N/F] + . [FOcUs N/F] + [l : Focus Near
[IRIS C/O] + Runs the IRIS Open/Close operation.
- [IRIS C/O] + B : IRIS Open
[IRIs €/0] + [ - RIS C/O] + B IRIS Close
When you click a number + [PRESET] button, the preset
[PRESET] . . ;
corresponding to each button number is activated.
2
2] | PTZ control When you click a number + [GROUP] button, Group/
[GROUP] Scan corresponding to each button number is
activated.
When you click a number + [TRACE] button, Pattern/
[TRACE] Trace corresponding to each button number is
activated.
[ZOOM] + Runs the zoom in motion.
[zOOM] + Runs the zoom out motion.
3 | Mouse control [T. LOCK(L)]/ Uses the left/right button of the mouse in mouse
- [TRACK(R)] mode.
You can change the multi monitor selection by clicking
[MON.(CON.)] a number + [MON.(CON.)] button in the screen mode
(previous/next according to the monitor number).
When you click a number + [LAYOUT(SEQ.)] button,
[LAYOUT(SEQ.)] the layout corresponding to each button number is
activated.
When you click a number + [CAM] button, the camera
[CAM] ) . .
corresponding to each button number is activated.
(4) | Screen control Clicking once will display a single screen on the live
viewer. Clicking once again will return to the original
[ENTER] screen.
When you click a number + [ENTER] button in the live
viewer, the screen is split into the number input.
LCD SnapShot Button | Captures the video of the current tile.

LCD Ul Alarm Off
Button

Initializes the event.

Number + [TILE(VM)]

Moves to the tile corresponding to the number.
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Name Function
Changes the PTZ mode.
[PTZ(MENU)] Click the [PTZ(MENU)] button while in PTZ mode and
the screen mode will be changed.
Changes the mouse mode.
5) HIF
(5] | Mode Change | [SHIFT] + Click the [SHIFT] + [MENU(MOUSE)] buttons while in
[MENU(MOUSE)] . .
mouse mode and the screen mode will be switched.
[SHIFT] + [MON.(CON.)] | Changes the console mode.
[SHIFT] + [TILE(VM)] Runs the VMD control.
[SEARCH] Outputs the video of the current tile through live/
search.
- The video will be stopped.
[ | Plays and pauses the video.
5 Play screen
= | control - Starts/Ends manual recording of the video.
Fast plays in the forward direction when the wheel is
Shuttle wheel turned clockwise, or fast plays in the reverse direction
when the wheel is turned counter-clockwise.
Jog wheel Performs frame search.
0~9 Button to input a number.
[ESC(SETUP)] Initializes the input number.
Performs the motion as a key value designated to
(7) SPC-7000 is automatically generated.

[FAVORI(MACRO)]

Example) When the [FAVORIL(MACRO)] key is pressed,
the same motion that is activated when the user
presses a number + [MONITOR] + number + [TILE(VM)]
is carried out.
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